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 ملخص

جديدة للأبحاث في مجال علوم الجيولوجيا أبعادًا  التي قدمت في السنوات الأخيرة ا يعتبر الاستشعار عن بعد أحد التخصصات

لمناطق اللتنقيب في من أجل خلق فرص جديدة للباحثين، خاصة في مجال رسم الخرائط الجيولوجية والمنجمية المخصصة 

التي يتعذر الوصول إليها، والتي تقع في مناطق جيولوجية مختلفة، سواء كانت جافة ذات مناطق قاحلة أو رطبة ذات غطاء 

 نباتي.

هذا العمل هو دراسةٌ لرسم الخرائط الجيولوجية، باستعمال مختلف تقنيات الاستشعار عن بعد، من أجل الحصول على البيانات 

استطلاع  والجيولوجية ثم تمثيلها، تحليلها ودمجها من خلال جمع، معالجة ونشر البيانات الجيولوجية بهدف إجراءالجغرافية 

جيولوجي موثوق به، والمقارنة النسبية بين منطقتين جيولوجيتين في الجزائر: جبل الونزة في الشمال الشرقي، وغار جبيلات 

-Landsat-8مة الاستشعار عن بعد متعدد الأطياف وخاصة استخدام صور في الجنوب الغربي، وهذا من خلال تقييم مساه

OLI  في التمييز الليثولوجي من أجل اكتشاف ورسم الحدود الجغرافية الممتدة، مما قد يسهل من عملية تصميم نماذج ثلاثية

  كلاسيكية السابقة.الأبعاد للرواسب الحديدية لكل منطقة جيولوجية ومقارنتها مع نتائج البحوث الأكاديمية ال

 خام الحديد. الفضائية،الصور  والمعدني، الجيولوجي التخطيط بعد، عن الاستشعار : الدالة الكلمات

 

ABSTRACT 

Remote sensing is a discipline that in recent years has introduced new dimensions of research 

In geosciences in order to create new opportunities to geologists, particularly in geological and 

mining mapping destined for mining prospection and in inaccessible areas, located in different 

geological regions, whether they are desert with arid areas or humid with vegetated areas as 

well. 
 

This work is part of a geomatic mapping study, involving the commitment of various remote 

sensing techniques, bringing together all the tools and methods to acquire, represent, analyze 

and integrate geological and geographic data through the collection, processing and diffusion 

of geological data, with the aim to perform a promising geological recognition as reliable as 

possible and a comparative dimensioning between the two geological regions of Algeria, 

namely Djebel-Ouenza in the North -East and Gara-Djebilet in the South-West, and this, by 

evaluating the contribution of multi-spectral remote sensing and particularly the use of Landsat-

8-OLI images support media in lithological discrimination in the perspective of the detection 

and mapping of boundaries and extended geological and geographical areas, possibly leading 

to 3D modeling, of ferriferous metal deposits of each geological region and compare them with 

the results of previous classical academic research. On the other hand, it should be noted that 

the results of this research work have been better and more perceivable in Gara-Djebilet than 

that in Ouenza. 
 

Key words : Remote sensing, geological and mineral mapping, satellite images, iron ore. 

 

RESUME 

La télédétection est une discipline, qui durant les dernières années a introduit de nouvelles 

dimensions de recherches dans les géosciences permettant de créer de nouvelles opportunités 

qui s’offrent aux géologues, particulièrement lorsqu’il s’agit de la cartographie géologique et 



minière destinée à la prospection et exploration minière en zones inaccessibles, situées dans 

différentes régions géologiques qu’elles soient désertiques à surfaces arides ou humides à 

surfaces végétalisées. 

Le présent travail, s’inscrit dans le cadre d’une étude de cartographie géomatique, impliquant 

l’engagement des diverses techniques de télédétection, regroupant l'ensemble des outils et 

méthodes permettant d'acquérir, de représenter, d'analyser et d'intégrer les données 

géologiques et géographiques au moyen de la collecte, traitement et diffusion des données 

géologiques, dans le but d’effectuer une reconnaissance géologique prometteuse aussi fiable 

que possible et un dimensionnement comparatif entre les deux régions géologiques d’Algérie 

soit Djebel-Ouenza au Nord-Est et Gara-Djebilet au Sud-Ouest, et ce, par l’évaluation de la 

contribution de la télédétection multi-spectrale et particulièrement l’utilisation des supports- 

images Landsat-8-OLI dans la discrimination lithologique dans l’optique de la détection et la 

cartographie des limites et étendues géologiques et géographiques, pouvant déboucher 

éventuellement sur une modélisation en 3D,  des gisements métalliques ferrifères de chaque 

région géologique et établir un comparatif par rapport aux résultats des travaux de recherches 

académiques classiques antérieurs. Par ailleurs, notons en substance que les résultats de ce 

travail de recherche ont été meilleurs et beaucoup plus perceptibles au niveau de Gara-Djebilet 

qu’à Ouenza. 

 

Mots clés : Télédétection, cartographie géologique et minérale, images satellites, minerai de 

fer.  
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INTRODUCTION GENERALE  

L’Algérie, qui est un pays riche de par ses ressources naturelles, a accordé depuis 

l’indépendance une importance majeure au secteur minier, et ce, pour répondre à ses 

préoccupations économiques. Bien que le pays dispose d’une immense diversité géologique, il 

fait néanmoins face à un grand défi, qui consiste en la mise en valeur des sites miniers 

potentiellement riches en gisements métallifères et minéraux. Au fil du temps, la croissance 

économique et la demande du marché en matière de ressources minérales, ont favorisé la 

prédominance de l’exploitation de certains minerais par rapport à d’autres, dont le minerai de 

fer qui a une place prépondérante dans le domaine de l’industrie extractive et le marché 

industriel, et c’est la raison pour laquelle nous allons consacrer ce travail de recherche à la 

prospection minière par satellite des deux grands gisements métalliques ferrifères, dont le 

premier situé au Nord-Est Algérien et qui correspond au site minier de l’Ouenza représentant 

le principal fournisseur en minerai de fer, alimentant à la fois le marché national Algérien et 

international, quant au deuxième, représenté par le gisement de Gara Djebilet, situé au Sud-

Ouest Algérien, qui constitue un site minier d’une immense réserve non encore ouvert à 

l’exploitation.  

 

L’exploration des gisements miniers est un défi que l’ingénieur des mines doit 

approcher avec le plus d’informations possible. C’est pour cela que la télédétection joue un rôle 

très prometteur dans les investigations des caractéristiques géologiques des surfaces à explorer 

sans la nécessité d’un déplacement sur terrain, et ce par l’acquisition, l’analyse et 

l’interprétation des données recueillies. 

 

La télédétection implique de ce fait, la collecte d’informations d’une surface cible tout 

en mesurant les radiations réfléchies (ou émises) par celle-ci. Ainsi, la télédétection s’appuie 

sur  un ensemble de techniques utilisant des appareillages et équipements incluant des organes 

très sensibles tels que les capteurs spécialisés permettant la collecte d’informations, structurées 

en données images numérisées adaptées à chaque bande spectrale, couvrant de larges surfaces 

terrestres. Les données issues de ces capteurs sont utilisées, notamment, dans des projets de 

recherche de nature à répondre aux besoins du marché économique, industriel et technologique, 

et aussi la surveillance de l’état de surface terrestre territoriale d’un pays donné,  afin d’aboutir 

par exemple à une modélisation représentative et fidèle à la nature des surfaces géographiques 

et géologiques à explorer. 

 

A cet effet, l’application de la télédétection a ouvert une nouvelle ère dans le domaine 

de l’exploration minière permettant ainsi de développer de nouvelles méthodes basées sur des 

techniques d’identification et de reconnaissance de la nature des différents types de gisements 

rocheux, abritant des concentrations de substance utiles à valeur marchande formant des 

minerais exploitables très variés, en relation avec  les conditions tectoniques d’une région 

géologique donnée. 
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L’objet de notre projet de fin d’étude vise à orienter les prospecteurs miniers vers les 

zones susceptibles de contenir des concentrations intéressantes de minerais métalliques 

exploitables. A ce titre, nous nous intéresserons plus particulièrement aux gisements 

métallifères ferrifères de la région du Nord-Est algérien, en cours d’exploitation, et de la région 

du Sud-Ouest Algérien, non encore exploité. Dans notre approche, nous allons nous appuyer  

sur les techniques de télédétection permettant une localisation automatisée et non couteuse des 

surfaces géologiques substantiellement minéralisées, ainsi que l’acquisition d’informations sur 

des zones non accessibles à l’homme. 

 

Ainsi, l’objectif principal de notre étude est de mettre en valeur les méthodes de 

traitement d’images satellitaires adéquates à des fins de prospection minière, et ce, pour obtenir 

des résultats aussi précis que possible et nécessaires pour la réalisation d’un modèle géologique 

de la zone d’étude. 

Pour atteindre cet objectif, nous devons répondre aux objectifs spécifiques suivants : 

 

 Délimitation, localisation et dimensionnement des gisements métalliques ferrifères du 

Nord-Est et Sud-Ouest algérien ; 

 Reconnaissances et identification des formations géologiques par télédétection ; 

 Comparaison entre les méthodes de télédétection utilisées pour la détection des 

gisements métalliques ferrifères appartenant à deux régions géologiques différentes. 

 

La réalisation d’un tel projet de recherche s’appuyant sur la télédétection nécessite une 

synthèse de recherche bibliographique englobant l’ensemble des informations requises 

(données géologiques du terrain à partir des travaux de recherches réalisés antérieurement, carte 

géologiques, données géochimiques, etc.) et requiert aussi une bonne maîtrise des méthodes et 

outils de traitement de données afin d’obtenir des résultats satisfaisants.  

 

Le présent document est réparti en quatre chapitres. Le premier décrit le cadre 

géographique et géologique des sites d’étude, dans lequel sont détaillées les diverses 

caractéristiques aussi bien sur le plan structural que sur le plan stratigraphique.  

  

Le deuxième chapitre représente des notions globales sur la télédétection dans son sens 

le plus large et son application dans le domaine minier en particulier. 

 

Le troisième chapitre a été consacré pour définir le matériel et les méthodes 

habituellement appliqués à des fins de prospection, ainsi que les paramètres et techniques 

utilisés dans notre cas d’étude. 

 

Enfin, le quatrième et dernier chapitre comporte le traitement et l’interprétation des résultats.  

 



 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Chapitre 1 
 

Cadre géographique et contexte géologique 

des zones d’étude 
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Introduction  

Le présent chapitre nous permettra d’avoir une description détaillée des différentes 

caractéristiques inhérentes au cadre géographique et au contexte géologique des deux régions 

abritant les sites miniers ferrifères. Il est nécessaire de mener une étude globale définissant les 

particularités géologiques propres aux deux zones d’étude dans le but d’exploiter le maximum 

de données recueillies  et les mettre au profit de l’utilisation de la télédétection, et ce, dans 

l’optique de repérer les limites et identifier la nature minéralogique du minerai des deux 

gisements ferrifères présentant la même minéralisation mais appartenant à deux régions 

géologiques différentes. 
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1. GEOLOGIE REGIONALE  
 

1.1. Les monts Mellègue 

 

1.1.1. Cadre géographique 

Les monts Mellègue font partie des masses montagneuses de l’Atlas tellien au nord et 

des Monts de Tébessa, avant-postes de l’Atlas Saharien, au sud qui se poursuit en Tunisie par 

l’Atlas tunisien. Ils se localisent dans la partie nord-oriental de la chaine des Maghrébides de 

l’Algérie du nord qui s’étend de Gibraltar à Calabre  sur plus de 2000 km, et ils sont délimités 

au nord et à l’ouest par les bassins de Sédrata et de Merhana. Ces monts représentent une région 

d’étude de plusieurs auteurs tels que (Durand Delga, 1955 ; Dubourdieu 1956 ; R. Guiraud, 

1973; Wildi, 1983 ; Coiffait, 1992 ; Chadi, 2004). 

  

1.1.2. Contexte de géologie structurale  

 

 

La région d'étude appartient au bloc extrême oriental de l'Atlas Saharien qui se 

caractérise par d’importantes couvertures méso-cénozoïques avec une puissance d’environ 

4000 à 5000 m ayant subies de fortes contraintes compressives affectant plusieurs zones de la 

région, qui sont identifiées généralement par des unités évaporitiques du Trias et coupées par 

des fossés d’effondrement (Othmanine, 1987). 

 

 

Figure 1.1 : Principaux ensembles structuraux de l’Afrique du Nord et situation de la région 

d’étude (L. Beguiret, 2007) 

 

L’Atlas saharien, du Sud-Ouest vers le Nord-Est est constitué de trois faisceaux de plis 

établis en échelons et regroupant ainsi : 
 

 Les Monts des Ksour, Djebel Amour. 

 Les Monts d’Ouled Nail, les Aurès. 
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 Les Monts de Mellègue, qui représentent une partie qui s’étend de l’Atlas saharien 

jusqu’à l’Atlas tunisien. 

Le Nord-Est algérien présente une très importante concentration en gîtes métallifères 

minéralisés suite à une intense activité magmatique qui s’est manifestée durant le Miocène. Sur 

le plan structural, deux directions majeures caractérisent la région : 
 

 La direction NE-SW marquée par les extrusions triasiques. 

 La direction NW-SE à WNW-ESE, marquée par les fossés d’effondrements. 
 

Ce qui explique l’existence d’une continuité des grands ensembles structuraux au niveau 

de la frontière Algéro-tunisienne où les minéralisations arrivent obliquement sur cette dernière,  

(H. Rouvier, 1990).  

 

Les traits structuraux majeurs de la région sont définies par :  
 

a. La  subsidence   

Selon (Masse et al, 1982) et (Bouzenoune, 1993), la tendance générale qui caractérise la région 

est une subsidence considérable, brève et continue entrainant des poussées horizontales de 

direction NE- SW suivie d’un bombement sous-marin formant des hauts- fonds qui sont induits 

par l’activité diapirique à partir des fractures profondes du socle.  
 

b. Le diapirisme 

Le diapirisme est contrôlé par le fluage et l’ascension (Perthuisot, 1988). L’une des 

principales caractéristiques de la région est exprimée par les diapirs qui sont allongés sur une 

bande d’environ 80 km en direction NE-SW. 
 

c. Les plissements  

Suivant la direction NE-SW l’ensemble des formations sédimentaires a été plissé, tel 

que ces plis anticlinaux sont généralement relayés par des vastes structures synclinales. D’après 

(Dubourdieu, 1956), la série du Mellègue a été plissée au cours du Paléogène (Eocène supérieur-

Oligocène).  
 

d. La tectonique cassante  

Les structures anticlinales sont recoupées par deux systèmes de failles :  

 Un système primaire orienté selon deux directions tectoniques : Nord-Est (30°- 60°) et 

Nord-Ouest (280° - 320°), et qui est constitué par des failles majeures orientées 

subparallèlement aux axes des anticlinaux sous l’effet du plissement tels que les couches 

tendres se plissent et les couches dures se cassent au niveau des pendages des roches 

qui sont subverticaux à inverses.  

 Un système secondaire caractérisé par d’importants rejets et de pendages de l’ordre de 

60° de direction Est-Ouest ; presque perpendiculaire aux failles principales, favorisant 

ainsi les concentrations métallifères.  
 

e. Les fossés d’effondrements  

La région est représentée par des fossés d’effondrements ayant une puissance d’environ 

170- 300 m sont enveloppés par des accidents majeurs avec des dépôts plio-quaternaires, selon 
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(Dubourdieu et al, 1950 ; Zouari, 1984), les fossés d’effondrements sont le résultat d’une intense 

activité tectonique distensive post-miocène inferieur. 

 

1.1.3. Contexte de géologie lithostratigraphique  

Selon plusieurs études effectuées dans la région des confins algéro-tunisiens par 

plusieurs auteurs tels que (Dubourdieu, 1956 ; Rouvier, 1977 ; Perthuisot, 1978 et Perthuisot, 1992), on 

considère que la présence d’une formation triasique large dite « zone des diapirs » est liée aux 

phases compressives depuis l’Aptien jusqu’au Quaternaire, telles que cette région s'étale sur 

une centaine de kilomètres entre les Monts du Mellègue au Nord et la flexure saharienne au 

Sud. 

 
Figure 1.2 : Carte de géologie régionale (Dubourdieu, 1956) 

 

Suivant les travaux de recherches de plusieurs géologues comme (Dubourdieu ; 1956, 

Chikhi; 1980 et Vila ; 1994) la lithologie ainsi que la subdivision stratigraphique de la région ont 

été établis dans les formations où l’on trouve des dépôts Mésozoïques-Cénozoïques allant du 

Trias au Quaternaire, encaissant généralement des minéralisations polymétalliques et ferrifères 

où nous distinguons :  
 

a. Le Mésozoïque (Secondaire) 
 

 Le Trias  

Le Trias des Monts Mellègue est dit diapirique où il se retrouve au centre des structures 

anticlinales avec d’importants affleurements qui sont : Boukhadra, Ouenza, Hamimat Nord 

et Hamimat Sud, et Mesloula (Dubourdieu, 1956 ; Perthuisot et Rouvier, 1992 ; Aoudjehane et al. 

1990 ; 1992). Il regroupe les différentes formations lithologiques telles que les marnes 
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bariolées à gypse, les dolomies, les calcaires dolomitiques, les grès et les fragments de 

roches. 

 

 Le Crétacé 

 Le Crétacé inférieur où on retrouve les étages suivants :  

Le Barrémien  

Selon (Dubourdieu, 1956), le barrémien affleure dans l’anticlinal de Sidi Embareka au 

Nord-Est de Djebel Ouenza avec une puissance de 200 m en moyenne ; il est formé de 

marnes grises et jaunes non fossilifères, intercalées par des calcaires argileux, 

noduleux. 

L’Aptien  

L’affleurement de l’Aptien s’étend sur des vastes surfaces, d’où il devient le plus 

remarquable dans la région. Ces dépôts ont un rôle de milieu encaissant important pour 

la mise en place de minéralisations polymétallique et ferrifère et sont distribués 

beaucoup plus, dans le noyau des anticlinaux, dans les bandes soulignées par les 

diapirs et dans d’autres horsts de la région. La formation aptienne représente une 

épaisseur totale entre de 250 à 600 m (Dubourdieu, 1956).  

Suite à l'étude lithostratigraphique de l'Aptien, il a été retenu la succession suivante :  

 L'Aptien marneux : On note la dominance des marnes verdâtres qui sont 

surmontées par des bancs de calcaires gréseux ou des grès sur une vingtaine de 

mètres telle que ces marnes  représentent les termes les plus anciens de l'Aptien 

(Masse et Thieuloy, 1979). 

 L'Aptien calcaire : Ces calcaires représentent un métallotecte lithologique car 

ils encaissent l'essentiel de la minéralisation ferrifère et/ou polymétallique 

(Dubourdieu, 1956 ; Bouzenoune, 1993). Ils renferment le plus souvent des Milioles, des 

Rudistes, des Orbitolines et des Lamellibranches (Chikhi-Aouimeur, 1980). 

Le Clansayésien  

Ce dernier ayant une puissance entre 100 et 200 m, affleure dans divers anticlinaux de 

la région où on trouve des marnes grises, jaunes à Ammonites avec des calcaires 

gréseux (Dubourdieu, 1956).  

L’Albien  

Les dépôts albiens ont une puissance entre 400 et 500 m, dans la partie inférieure, 

l’Albien est composé de marnes argileuses, dans sa partie moyenne de calcaires, tandis 

que dans sa partie supérieure on y trouve des marnes noires. Suivant les recherches de 

Dubourdieu, (1956), les calcaires aptiens sont surmontés par des marnes datées de 

l’Albien inferieur et on trouve aussi selon Vila et al (1994) la présence d’une barre 

carbonatée albienne qui s’individualise à l’Ouenza. 

Vraconien  

Ayant une épaisseur de 500 m, il se compose essentiellement de marnes calcaires 

grises, bleues, séparant des petits bancs de calcaires et vers le bas des marnes calcaires 

très gréseuses. 
 

 Le Crétacé supérieur, on y distingue les étages suivants :  

Le Cénomanien  
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Avec une puissance entre 600 et 900 m, le Cénomanien est constitué de marnes 

argileuses verdâtres, caractérisées par des intercalations de la calcite fibreuse, plus 

explicitement on a deux assises (Dubourdieu, 1959) : 

 L’assise inferieure, constituée de marnes jaunes avec des marnes calcaires 

blanches feuilletées. 

 L’assise supérieure, formée par des calcaires argileux, gris blancs avec quelques 

niveaux de calcaires gris noirs. 

Le Turonien  

N’affleurant qu’aux environ de l’Ouenza et avec une puissance de 150 à 250 m, les 

formations turoniennes constituent les flancs des grands anticlinaux et synclinaux 

présentées essentiellement par des calcaires marneux en plaquettes gris- foncé à noir, 

et à la base, avec de la matière organique et de rares concentrations pyritiques et 

marcacitiques.  

Le Sénonien  

Le Sénonien selon (Dubourdieu, 1959) est représenté par : 

 Le Sénonien inférieur : Ayant une puissance supérieure à 300 m et caractérisé 

par des calcaires marneux et des marnes. 

 Le Sénonien supérieur : Affleurant au Sud de Tébessa avec une puissance entre 

200 et 500 m est représenté par la succession des calcaires marneux du Campanien, 

des marnes gypsifères et enfin des calcaires massifs à rognons de silex riches en 

Inocérames avec une épaisseur comprise entre 200 à 500 m. 

 

b. Le Cénozoïque (Tertiaire) 

Les dépôts tertiaires selon David (1956) sont caractérisés par : 

 Le Paléogène 

 L'Eocène  

Avec une puissance d’environ 200 m, l’Eocène est caractérisé par des calcaires à silex 

et des calcaires à Nummulites, près des périmètres des Monts de Mellègue.  

 Le Néogène 

 Le Miocène inférieur et moyen  

Ils comportent une puissante accumulation de marnes et de grès, avec une épaisseur 

qui atteint les 1000 m (Dubourdieu, 1956; Kowalski et Hamimed, 2000) et aussi des 

conglomérats contenant des éléments de calcaires variés, de silex gris, des galets 

ferrugineux et des éléments du Trias (Bouzenoune, 1993), avec une épaisseur moyenne 

de 150 m (Dubourdieu, 1956).  

 Le Mio-Pliocène  

Avec une puissance de 150 m, il est distribué essentiellement dans la moitié Nord de 

la région, et représenté par des conglomérats bariolés, des grès et des sables, des argiles 

et des calcaires lacustres. Sa puissance est de 150 m.  

c. Le Quaternaire  

Il renferme des croûtes de calcaires, limons, éboulis, cailloutis et poudingues avec une 

épaisseur de 10 à 30 m dans les fossés (Dubourdieu, 1956). Il est caractérisé aussi par des 

dépôts couvrant d’importantes surfaces étalées sur les parties basses des reliefs. 
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Figure 1.3 : Colonne lithostratigraphique synthétique des monts du Mellègue (D’après 

Dubourdieu 1956, 1959 ; David 1956 ; Madre 1969 ; Fleury 1969 ; Thiéberoz et Madre 1976 ; Chikhi 1980 ; 

Othmanine 1987 ; Bouzenoune 1993 et Vila et al, 2000) 

 

1.2. Le bassin de Tindouf 

 

1.2.1. Cadre géographique  

 

Le Bassin de Tindouf occupe la partie occidentale de la plateforme saharienne 

algérienne, occupant une surface d’environ 160 000 km. Le bassin de Tindouf s’étend de la 

vallée du Draa de l’Anti-Atlas marocain au Nord jusqu’au massif des Eglab (partie orientale du  
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Grand massif de Reguibet), il est limité à l’Est par la chaîne de l’Ougarta, à l’Ouest par la frontière 

Algéro-Marocaine (Fig. 1.4). 

 

Figure 1.4 : Contexte morphostructural du bassin de Tindouf (FABRE, 2005) 

 

1.2.2. Contexte géologique  

 

a. Plan structural 

La position du bassin de Tindouf entre l’Anti Atlas marocain et le massif des Eglab, lui 

donne un caractère stable sur le flanc Sud et plus ou moins instable sur le flanc Nord, et ceci 

est dû aux différentes orogenèses résultantes des collisions intercontinentales qui ont affecté la 

plaque Africaine et la plaque Nord-Américaine (WILSON, 1968 et SHENK, 1971).  

Les processus tectoniques affectant la couverture de la région (GEVIN, 1960) sont illustrés par les 

phases suivantes :  

 La phase cadomienne  

Cette phase a introduit un système d’ondulation NW-SE tout en mobilisant les 

sédiments infracambriens avec détermination des horsts et grabens.  

 La phase calédonienne  

Représentée par des bombements du socle, principalement vers le méridien 6° Ouest. 
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 La phase hercynienne  

Cette phase se caractérise par des plissements qui ont défini l’immense synclinal 

dissymétrique de Tindouf. Cependant, la fin de cette phase a engendré l’apparition 

d’immenses failles orientées (NE, SW) générées par des remontées doléritiques. 

 

 La phase des mouvements post hamadiens 

Les courbures stratigraphiques du Paléozoïque ont subi des mouvements tectoniques de 

cette phase.   

 

 La Phase permanente  

Cette phase est liée particulièrement au tassement des couches, introduisant ainsi des 

failles méridiennes tracées par les grands traits antécambriens. 

 

b. Plan lithostratigraphique  

Selon les travaux de recherche antérieurs de FABRE, 1976, HOLLARB, 1970 et CHABOU, 

2001. Le bassin de Tindouf est caractérisé par des changements étonnants de puissance et de 

faciès. Le classement se fait de bas en haut comme suit : 

 Le Précambrien  

Dans cette ère, repose la série initiale schisto-quartzitique où on trouve une succession 

lithologique présentée comme suit : 

 Le groupe (II-III) Saghro Précambrien : représentant particulièrement des 

volcano- détritiques. 

 Le groupe de l’Ouarzazate : des volcano-détritiques. 

 Le Précambrien III : à la différence des autres groupes celui-ci est composé de 

schisto-quartzitique.  

 Le Paléozoïque 

Reposant sur la discordance panafricaine, le Paléozoïque est constitué de :  

 Le Cambrien  

Le Cambrien inférieur   

Il comprend également les faciès suivants :  

 Ensemble carbonaté : correspond à une série avec une épaisseur de 200 m en 

moyenne, renferme les plus anciens Trilobites connus au monde, et elle est 

composée de lit argileux en alternance avec des bancs de calcaires. 

 Ensemble schisto-calcaire : représentant une alternance de schiste verts à 

Trilobites et de calcaires à Archéocyathidés avec une épaisseur de 150 m. 

 Ensemble détritique : Il correspond à des grès à Tigillites surmontés par des 

schistes à Trilobites marquant le passage au Cambrien moyen (CHABOU, 2001), et 

renfermant aussi par endroit des tufs volcaniques. 

Le Cambrien supérieur  

Il est constitué de bas en haut par : 

 Un ensemble schisteux : correspond à une série avec une épaisseur d’environ 

400 m,   couronnée par la formation des grès à Paradoxides et Lingules. 
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 Un ensemble gréseux : avec une épaisseur qui atteint 450 m, cette série devient 

étroite en allant du Nord vers le Sud et disparait totalement dans la région des 

affleurements paléozoïques du flanc Sud du bassin de Tindouf (CHABOU, 2001).  

 L’Ordovicien  

L’Ordovicien se remarque par la prépondérance des schistes, tels que nous 

distinguons la succession suivante de bas en haut : 

 Les schistes : Dans certaines régions, des argilites plus ou moins silteuses sont 

rencontrées, riches en Graptolites et Trilobites du Trémadocien. Cependant, on 

rencontre aussi d’autres formations telles que les argiles glauconieuses riches en 

Graptolites. 

 Les grès sont présents en grains fins à grossiers, riches en Scolytes.  

 Les argiles : elles se distinguent par un faciès argileux, silteux, micacés et des 

grès riches en fossiles. 

 d’autres types de grès qui comportent des schistes marqués par des argilites à 

intercalation de grès riches en faunes, mais aussi des grès quartzitiques à grains fins 

à moyen.  

 Le Silurien  

Dans la bordure Sud du bassin de Tindouf, le Silurien est surtout schisto-argileux. Cet 

ensemble, dénommé formation de « la Sebkha Mahbès » (50 à 120 m) s’étend du 

Liandoverien moyen au Pridolien (CHABOU, 2001).  

Dans le flanc Nord du bassin, la série argileuse s’épaissit et peut atteindre 800 m. Elle est 

représentée par des argiles à Graptolites avec des intercalations gréseuses, ainsi que des 

calcaires à Crinoïdes, Orthocères et Lamellibranches.  

 Le Dévonien  

La série lithostratigraphique dévonienne comprend :  

Le Dévonien inférieur  

Au Nord du bassin de Tindouf, le Dévonien inférieur comprend les deux formations 

suivantes (CHABOU, 2001) : 

 Une formation argileuse : de 400 m à l’Ouest et quelques dizaines de mètres à 

l’Est où s’intercalent des niveaux gréseux et des calcaires. 

 Une formation gréseuse : de 700 à 800 m, est constituée par des bancs de grès 

formant des crêtes (les Rich). Ces grès comportent des calcaires fossilifères datés 

de l’Emsien.  

Au Sud du bassin de Tindouf, le Dévonien inférieur connu sous le nom de Formation 

de « Gara-Djebilet ». Cette dernière est subdivisée en deux membres :  

 Les grès de Gara-Djebilet : sont représentés en grande partie par des grès à 

intercalations argileuses et des argilites.  

 Les grès supra-minéraux : Ils comprennent à la base des grès, suivi par des 

argilites admettant des bancs de calcaires. La faune indique un âge Emsien. 

Le Dévonien moyen  

Dans le Nord du bassin de Tindouf, le Dévonien moyen est constitué par les 

formations suivantes :  



Chapitre 1 : Description du cadre naturel de la région d’étude                                                                               . 

 

29 
 

 Une formation argilo-calcaire : épaisse de 300m, comportant des schistes à 

Goniatites, des grès et de quelques niveaux calcaires. Cet ensemble est daté 

Eifelien.  

 Une formation calcaire : D’âge Givétien très fossilifère (Goniatites, Arthrodires, 

Trilobites). La puissance de cette formation est faible (50 à 100m).  

Au Sud de ce bassin, le Dévonien moyen correspondant à la formation de 

l’Oued Talha. Cette formation est subdivisée en deux membres :  

 Les argilites de l’Oued Talha : Sont constituées d’un ensemble homogène 

d’argilites grises, feuilletées, avec des intercalations de bancs de calcaires gréseux 

riches en Brachiopodes. Ce membre serait d’âge Emsien supérieur à Eifelien.  

 Les calcaires bioclastiques de la Kerb-Tsabia : Comportent des calcaires durs et 

compacts, formant de gros bancs intercalés d’argilites, qui sont très riches en 

Brachiopodes et Polypiers. L’âge de ce membre est Eifelien à Givétien supérieur. 

 

Le Dévonien supérieur  

Il est représenté au Nord du bassin de Tindouf par une puissante série argileuse « les 

argiles de la plaine du Draa ». Cette dernière comprend un Frasnien argileux à 

intercalations calcaires, un Famennien inférieur entièrement argileux et un Famennien 

supérieur argileux à intercalations gréseuses et gréso-calcaires. L’épaisseur du 

Dévonien supérieur peut atteindre 3000 m.  

Au sud du bassin de Tindouf, le Dévonien supérieur correspondant à la formation de « 

Kerb En-Naga » (220 à 300 m d’épaisseur). Cette formation comprend deux membres :  

 Les siltites de l’Oued Rhazzal : Elles sont marquées par des argiles grises, 

indurées et des bancs gréseux à grains très fins. 

 Les argilites de l’Oued Slouguia : Argile grises papyracées, couronnées par des 

lits de gypses translucides.  

 Le Carbonifère  

Le Carbonifère du flanc Nord du bassin de Tindouf est subdivisé en quatre unités 

lithostratigraphiques sur la base d’arguments stratigraphique, lithologique et 

morphologique, (CHABOU, 2001) : 

Les grès et schistes de Tazoult, avec 111 m d’épaisseur : ils appartiennent au 

Tournaisien supérieur (HOLLARB, 1970). 

Les grès et schistes de la Bétaina, avec 800 m d’épaisseur : ils sont datés du Viséen 

inférieur et de la première partie du Viséen supérieur. 

La série de l’Ouarkziz, comprend trois membres : 

 Les calcaires inferieurs de l’Ouarkziz, avec 356 m d’épaisseur : c’est des 

calcaires à Gigantoproductidés et polypiers du Viséen supérieur.  

 L’Ouarkziz moyen, avec 111,5 m d’épaisseur : composé d’argiles et de marno- 

calcaires dolomitiques, avec localement des lentilles de gypse massif. Ce membre 

correspond à la limite Viséen supérieur-Namurien.  

 Les Calcaires supérieurs de l’Ouarkziz, avec 102 m d’épaisseur, correspondent 

à des calcaires à Gigantoproductidés et polypiers du Namurien. 
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La série de la Bétaina : de nature continentale, comprend :  

 A la base, la formation des grès du Djebel Réouina (500 m d’épaisseur), 

composée des grès, d’argilites et des calcaires. Elle contient de nombreux débris de 

végétaux terrestres du Namurien.  

 Au sommet, la formation de Merkala (500 à 700 m d’épaisseur), est constituée 

essentiellement par une alternance de grès à grains fins, en bancs métriques, et 

d’argiles rouges. Cette formation contient des fougères caractéristiques du 

Stéphanien inférieur.  

Le Carbonifère du Sud du bassin de Tindouf comprend les formations suivantes : 

 La formation « de Kerb-Slouguia » : Elle est composée des grès et des calcaires 

passant à des argiles et des grès. L’épaisseur de la formation atteint 584 m. 

 La formation « de Kerb-Sefiat » : D’âge Viséen inférieur. Sa base est composée 

de grès, passant à une alternance d’argiles et de passées de calcaire gréseux à son 

sommet. L’épaisseur de cette formation est de 310 m. 

 La formation « d’Aïn-el Barka » : Correspond au Viséen supérieur. Elle 

comprend des marnes gréseuses, des grès tendres et des bancs de calcaire. 

L’épaisseur de cette formation atteint 600 m. 

 La formation de « Hassi-Aouloulel » : elle est représentée par des sédiments 

argilo- gréseux indifférenciés du Namurien et du Westphalien. Son épaisseur atteint 

345 m.  

 Le Cénozoïque (Le Tertiaire) 

Dans le bassin de Tindouf, les terrains post-paléozoïques sont représentés par la Hamada 

de Tindouf (ou du Draa), qui ne dépasse jamais 100 m d’épaisseur.  

Cette formation est constituée essentiellement d’un complexe gréso-argileux, d’âge 

probablement Paléocène, supportant une dalle calcaire d’origine lacustre Néogène. 

Selon (FABRE, 1976, 2005), au Nord du bassin de Tindouf, la base de la Hamada 

comprendrait une série gréseuse du Cretacé́ inférieur, qui est surmontée par une dalle 

calcaire Cénomano- turonienne. Dans la partie centrale du bassin de Tindouf, les 

formations paléozoïques sont recouvertes par les terrains de Hamada.  

 Le Quaternaire 

Le Quaternaire comprend les regs, les alluvions, les éboulis, les sebkhas et surtout les 

ergs (dunes de sable), qui occupent une partie importante de la région (Erg-Iguidi). 

Sur la bordure Nord des Eglab (fig. 1.5), le Bassin de Tindouf renferme des 

affleurements paléozoïques (Ordovicien à Carbonifère) de qualité médiocre pour 

l’Ordovicien et le Silurien et meilleure pour le Dévono-Carbonifère. Le Bassin de 

Tindouf a été subdivisé en deux sous-bassins : le sous bassin de Djebilet et le sous bassin 

de l’Iguidi, séparés par le haut fond de Laroussi (Guerrak, 1987 ; Bitam et al., 1997).  

 

 

 

 

 

 



Chapitre 1 : Description du cadre naturel de la région d’étude                                                                               . 

 

31 
 

 

 

 

 

 

Figure 1.5 : Colonne lithostratigraphie du bassin de Tindouf (D’après CHABOU, 2001) 
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2. Géologie locale des zones d’étude 
 

2.1. Gisement ferrifère de Djebel Ouenza  

 

2.1.1. Localisation du cadre géographique  
 

La ville de l’Ouenza, comme chef-lieu de Daïra, se trouve à 90 km au Nord du chef-lieu 

de la Wilaya de Tébessa. Elle est située à 120 kilomètres au Sud-Est d’Annaba (Fig. 1.6). 

Le gisement ferrifère de l’Ouenza est localisé à 60 Km au Nord de la ville de Tébessa 

dans l’anticlinal du Djebel Ouenza, dont les coordonnées géographiques sont : 35° 56’ 41.8 » 

N et 8° 05’ 35.8 » E. 

Il repose sur le flanc nord d’un massif montagneux qui culmine à un pic de 1288 m, il 

est d’environ 12 km de longueur sur 5 km de largeur. Les amas métallifères, comprennent 

successivement du Nord-Est au Sud-Ouest : le Coudiat Douamis, le Coudiat Hallatif, la région 

des conglomérats, le quartier Sainte-Barbe, le gisement de Chagoura et le Coudiat Zerga. Le 

minerai affleure sur des longueurs atteignant parfois 250 mètres et des hauteurs de 45 mètres 

(CHAIN. R, 2006). 

La topographie est très caractéristique à celle de l’Atlas saharien. Son relief est assez 

accidenté. L’altitude maximale signalée à Djebel Ouenza est de 1206 m enregistrée au niveau 

du lieu Chagoura. 

Les réserves géologiques du gisement ont été estimées à 87 millions de tonnes avec une 

teneur en fer de 48%  dont les minéraux prédominants sont l’hématite, la goethite et la limonite.  

Figure 1.6 : Position géographique du gisement ferrifère de l’Ouenza (Google Maps, 2019) 
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Figure 1.7 : Carte topographique de Djebel Ouenza (Extrait de la carte topographique de Tébessa, 

1/50000, coordonnées UTM) 
 

2.1.2. Contexte géologique  
 

a. Plan structural  

Le massif de l’Ouenza est situé dans l'Atlas du Sahara oriental, au sein d'un bassin 

d'affaissement dans l'avant-pays orogénique nord-africain. La structure du massif de l’Ouenza 

correspond à un anticlinal dissymétrique de direction NE-SW où le noyau de ce pli est occupé 

par un diapir triasique qui a pénétré dans la couverture sédimentaire du Crétacé au milieu et à 

la fin de l'évolution du bassin (Aoudjehane et al, 1992). 

Figure 1.8 : Carte géologique schématisée du Djebel Ouenza (D’après Dubordieu, 1956, modifié 

par Vila, 1994) 



Chapitre 1 : Description du cadre naturel de la région d’étude                                                                               . 

 

34 
 

La structure du massif de l’Ouenza qui est due aux effets de la poussée diapirique du 

Trias, est affectée par des failles inverses et des décrochements de directions WSW-ENE et 

WNW- ESE.  

 

L'organisation structurale du massif de l’Ouenza est le résultat de la tectonique saline et 

de la compression néogène où on distingue trois zones triasiques :  

- Une zone centrale où les roches triasiques sont profondément enracinées. 

- Deux zones latérales, qui résultent de l'extravasation de l'évaporite centrale. 

 

Les formations les plus anciennes exposées en surface sont les séquences évaporitiques 

entremêlées (marnes bariolées à gypse, blocs de dolomies plus ou moins stratifiées, calcaires, 

cargneules, grès et rarement des ophites du Trias) qui présentent un noyau halitique où l’on 

trouve une zone avec anhydrite secondaire (< 20 m) et une zone supérieure avec du gypse (de 

50 à 200 m) (Bouzenoune, 1993).  

 

b. Plan stratigraphique  

La stratigraphie de l’Ouenza a été mise en place par un mouvement diapirique de deux 

périodes :  

La première période du mouvement diapirique fut connu par la pénétration de la matière qui 

s’est produite pendant l'Aptien et s’est enregistré par une re-sédimentations de matériaux 

triasique dans les calcaires aptiens, ensuite par un amincissement vers le sommet du diapir avec 

des variations lithostratigraphiques sur le sommet et dans les puits périphériques (Dubourdieu 

1956; Thibieroz et Madre 1976).  

La deuxième période de ce mouvement s'accompagnant d'une infiltration d'évaporite, 

s'est produite avant la transgression Vraconienne. Cette extrusion qui fut inscrite par la 

resédimentation de quartz triasique et de dolomie dans le conglomérat Vraconien, a inversé les 

strates apto-albiennes. Cependant, au cours du Néogène, la compression a impliqué une 

déformation des structures préexistantes et le retour de l'halokinésie. 

De ce fait, l’activité diapirique  a pesé sur le régime de sédimentation, c’est pourquoi on 

remarque que le massif de l'Ouenza possède un caractère pratiquement  sédimentaire car il est 

composé principalement de calcaires, de marnes et de grès selon la lithologie suivante : 

 

 Le Mésozoïque  

 Le Trias  

Le Trias est essentiellement représenté par des formations affleurant sur de 

grandes surfaces avec des couvertures sédimentaires par endroit. Ainsi, les 

marnes bariolées à gypse, les dolomies, les débris de calcaire et les grès forment 

les dépôts du Trias.  

 Le Crétacé 

L’Aptien  

Les dépôts sédimentaires de l’Ouenza sont caractérisés par deux lithologies 

distinctes, l’une à faciès carbonaté avec des intercalations de marnes et calcaire 

et l’autre à faciès terrigène composé de marnes, grès et calcaires.  
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Il est à noter que les calcaires micritiques en particulier, sont le siège des 

accumulations ferrifères. Le Clansayésien y est présent avec une unité d’une 

puissance d’environ 90 m, composée de marnes grises et gris-jaune contenant 

parfois des calcaires et des grès dans certains cas, minéralisés en oxyde de fer. 

L’Albien  

Les dépôts de cet étage sont répartis en trois niveaux :  

 Le niveau inférieur d’une puissance de 50 m, il représenté par une intercalation 

de marnes jaunes et grise-jaunes et de calcaires gréseux et argileux. 

 Le niveau moyen qui est composé de marnes gris-noires et d’inter-couches de 

calcaire et de calcaire argileux, possède une épaisseur de 130 m. 

 Le niveau supérieur est caractérise par une épaisseur de 200 m et un dépôt de 

marnes et de calcaires argileux. 

 Le Quaternaire  

Les formations sédimentaires du Quaternaire englobent essentiellement des travertins localisés 

au NE de la région et des éboulis de marnes et de carbonates.  

Cependant, on rencontre dans certaines zones limitées des couvertures de 2-3 m de formations 

d’anciennes nappes d’épandage, constituées de marnes. 

 

 

Figure 1.9 : Colonne lithostratigraphique de la coupe géologique de la mine de l’Ouenza 

(Khoudair Chaabane et al, 2015) 
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c. Minéralisation  

La mine de l’Ouenza est connue par une très importante minéralisation qui correspond 

à une accumulation ferrifère, cependant on trouve d’autres minéralisations polymétalliques 

associées au Fer comme le Cu, Pb, Zn, Ba et F. Ces gîtes sont généralement encaissés dans des 

calcaires à caractère récifal de l’Aptien. 

Le gisement contient de l'hématite qui est soit sous un aspect pulvérulent avec une 

couleur bleue ou noire rougeâtre, soit en tant que masse fade sans cristaux apparents ou encore 

en tant que masses homogènes ayant une toile rhomboédrique apparente reçue du minerai 

carbonaté.  

Cependant, dans les géodes ainsi que les zones de fracture on trouve la présence de la goethite 

accompagnant l’hématite qui est très fréquente sous forme d’encroutements à surface 

mamelonnée. 

Dans les zones bréchiques et de fracture, la limonite est fréquemment associée à la 

goethite, où elle correspond à des argiles imprégnées de limonites. Toutefois la sidérite et 

l’ankérite représentent les carbonates de fer qui montrent souvent un aspect bréchique (Chain.R, 

2006). 

 

Tableau 1.1 : Etat récapitulatif des réserves géologiques actualisées au 31/12/2007 (M.S. Taleb, 

2012) 

Site Réserves en tonne Teneur en Fe % 

Chagoura Nord 21071817 48,87 

Chagoura Sud - Pic 22408212 49,51 

Saint Barbe 13224377 47,7 

Conglomérat 6011290 47,4 

Hallatif 4931028 51,00 

Douamis 11419058 53,00 

Zerga 3405440 42,7 

TOTAL 82 471 222 ----------- 

Moyenne  -------------- 49,19 

 

 

2.2. Gisement ferrifère de Gara-Djebilet  

 

2.2.1. Localisation du cadre géographique 

Le gisement de minerai de fer de Gara-Djebilet est situé à 100 km environ au SSE sur 

le flanc Sud du bassin de Tindouf (Sud-Ouest de l'Algérie), et appartient à la ceinture de fer 

oolitique paléozoïque Nord-africaine. Il s’étale sur une distance dépassant les 3000 km de 

Zemmour (Mauritanie) jusqu’à la Lybie, et comporte des pierres ferrugineuses datant de 

l’Ordovicien, Silurien et Dévonien (Guerrak, 1988, 1991). 

Occupant une surface de plus de 131 km2 à 170 km Sud-Est de la ville de Tindouf, et à 

une altitude oscillant entre 400 et 600 m, dont les coordonnées géographiques sont : 26° 52' 

53.8" N et 7° 10' 0.6" W. Le gisement de Gara-Djebilet, découvert à partir de 1952, comporte 

des réserves minières de 1 540 millions de tonnes, avec une teneur en fer de près de 56%.  



Chapitre 1 : Description du cadre naturel de la région d’étude                                                                               . 

 

37 
 

Figure 1.10: Localisation géographique du gisement de Gara Djebilet (Bitam et al., 1997) 

Figure 1.11 : Carte topographique de la région de Gara Djebilet (Extrait de la carte topographique 

de Tindouf NG-29 N-E, 1/500000) 
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2.2.2. Contexte géologique  

 
Les sédiments du Dévonien inférieur (précoce) présents dans le bassin de Tindouf, connus sous 

le nom de "formation de Gara Djebilet", se composent principalement de grès avec des 

intercalations de schistes. Il est divisé en deux membres : 

 Le membre inférieur " Grès de Djebilet " de l'âge Lochkovien-Praguien. 

 Le membre supérieur " Grès supra-minéraux " de l'âge Emsien.   

 

 
Figure 1.12 : Extrait de la carte géologique de Gara Djebilet (Chabou, Saibi, Bersi ; 2015) 

 

a. Plan structural  

Les failles de direction NE-SW et ENE - WSW recoupant la région du flanc Sud du 

bassin de Tindouf représentent la cause principale de la tectonique affectant cette région, ces 

failles sont liées aux montées magmatiques (gabbro-dolérites).  

Les roches qui constituent la région d’étude se présentent sous trois formes : 

 En dykes : il s’agit de longs dykes d’environ 1 à 10 m d’épaisseur, orientés WSW-ENE, 

recoupant la série paléozoïque du flanc Sud du bassin de Tindouf entre les méridiens 6°10’ 

et 8°30’ Ouest. Cette forme correspond au type de structure le plus répandu dans cette 

région. 

 En sills : souvent injectés dans des formations argileuses du Famennien, cependant, ils 

sont rares et peu épais. Parfois d’autres sills affleurent à l’Est. 
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 En massifs intrusifs ou en cheminées : connues dans la région et touchent des surfaces 

importantes.  

La couverture sédimentaire du flanc Sud du bassin de Tindouf est constituée de dolérites d’âge 

postérieur au Carbonifère supérieur ou Mésozoïque.  

 

 
Figure 1.13 : Carte structurale de la région de Gara-Djebilet (d’après GEVIN, 1960) 

 

b. Plan lithostratigraphique  

Selon les travaux de recherche antérieurs (GEVIN, 1960; FABRE, 1978), la région de Gara-

Djebilet se compose en majeure partie de la série lithologique suivante :  

 Le Précambrien  

Caractérisé par la présence de granites. 

 Le Paléozoïque  

 Le Silurien  

Il comporte surtout des argiles et des séries monotones, il affleure en continuité de 

Zemmour jusqu’à l’Erg-Chech, mais avec une diminution des épaisseurs allant 

d’Aouinet à Bel-Egraa (de 120 à 200 m). 

 Le Dévonien  

Il affleure de l’Ouest à l’Est, et on y distingue plusieurs variations de faciès. Il est 

subdivisé en trois niveaux (GEVIN, 1960):  

Le Dévonien inférieur 

Représenté par d’importants changements dont l’épaisseur est de 150 m à Gara-

Djebilet à 60 m à Gour-Jiffa. La série lithologique des régions (pays Mecham, Bou-

Bernous), comme déjà mentionné par (GEVIN, 1960) est caractérisée de bas en haut par : 

- Des conglomérats à la base : le faciès conglomératique est rare et souvent substitué par 

des micros conglomérats ferrugineux. 
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- Une formation argilo-schisteuse surmontée à l’Ouest par une formation argilo-calcaire 

assez similaire à celle du Gothlandien sous-jacent. 

- Un complexe gréseux où les grès sont généralement grossiers et quelques fois 

ferrugineux et pouvant comporter des passées conglomératiques ou montrer des 

stratifications entrecroisées « Hard-grounds », et argilo-gréseux généralement micacé 

où on peut voir des ripple-marks, avec parfois des niveaux de minerai de fer.  

Le Dévonien moyen  

Caractérisé par des formations lithologiques d’origine marine affleurant dans le lit 

d’Oued Talha. Selon (GEVIN, 1960), les lithologies présentes dans le Dévonien moyen 

sont les suivantes : 

- L’Emsien terminal à Eifelien basal (ex Couvinien inférieur) : caractérisé par des argiles 

gréseuses à l’Ouest, des grès dans la zone située entre Gara-Djebilet et le Mabbès et des 

marnes calcaires à l’Est. L’épaisseur de cette formation varie de 5 à 15 m. 

- Le Couvinien supérieur d’une puissance maximale de 80 m à l’Oued Talha et composé 

de marnes gréseuses de couleur jaunâtre à Calceolas. 

- Le Givétien inférieur : formation marno-calcaire dont la puissance varie de 90 à 10 m à 

l’Est et possède une forme de bancs « coralligènes », quelques fois caractérisés par des 

lentilles, riches en polypiers et brachiopodes.  

Le Dévonien supérieur  

Cet ensemble possède une épaisseur variant de 300 à 220 m de l’Ouest vers l’Est, et 

comporte trois unités du bas vers le haut présentées comme suit : 

- Une formation argilo-gréseuse à intercalations de lentilles calcaires, généralement à 

lumachelles. 

- Une formation argileuse, argilo-gréseuse caractérisée par des ripple-marks avec de fins 

lits de gypse. 

- Une formation argilo-gréseuse allant vers l’argile silteuse vers l’Est. 

 Le Carbonifère 

Il représente les unités lithologiques du Paléozoïque du bassin de Tindouf, avec 

l’absence du Permien. On y trouve : 

Le Carbonifère marin  

Il est subdivisé en trois niveaux : 

- Le Tournaisien : caractérisé par une épaisseur qui varie de 50 à 150 m de l’Ouest vers 

l’Est avec des grès calcareux à l’Ouest et des argiles gréseuses au méridien 7° Ouest. 

- Le Viséen inférieur : ne comporte pas de discontinuités apparentes et possède une 

épaisseur qui croît de 80 à 300 m lorsqu’on se déplace vers l’Est. 

- Le Viséen supérieur : composé de marnes gréseuses et de grès tendres dont la puissance 

diminue en se dirigeant vers l’Est de 600 à 550 m. 

Le Carbonifère continentale  

Il est subdivisé comme suit : 

- Le Namurien : c’est une formation laguno-lacustre composée d’argiles gréseuses. 

- Le Westphalien : il affleure sur une distance de 80 m, composé d’argiles et de grès avec 

des restes de végétaux (Corynopteriscoralloïdes, Annularia-radiata et enfin Neuropteris gantes). 



Chapitre 1 : Description du cadre naturel de la région d’étude                                                                               . 

 

41 
 

 
Figure 1.14 : Colonne stratigraphique synthétique de Gara-Djebilet (modifié-Guerrak, 1988) 

 

c. Minéralisation  

Le minerai de fer oolitique de Gara-Djebilet est remarqué par une intercalation dans les 

sédiments du Dévonien inférieur, selon (Guerrak, 1988), ces sédiments sont situés dans les 

extrémités entre les grès argileux du Praguien du grès de Djebilet inférieur et les 

conglomérats/grès Emsien du grès supra-minéraux supérieur. 

On distingue trois gisements capitaux dans la région :  
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 Gara-Ouest avec 14 km de longueur, 4 km de largeur et 30 m d'épaisseur. 

 Gara-Centre avec 20 km de longueur, 5 km de largeur et 30 m d'épaisseur. 

 Gara-Est avec 7 km de longueur, 1 km de largeur, 9 m d'épaisseur. 
 

Ces trois principaux gisements s'étendent sur environ 60 Km d'Ouest vers l’Est (Guerrak, 

1988). 

Les dépôts se trouvent sous forme de mesas de lentilles oolithiques, de ferstone, plates 

discontinues par des sédiments essentiellement argileux et sableux.  
 

D’après (Guerrak, 1988), on distingue trois zones essentielles dans le gisement principal 

de minerai de fer de gara-Djebilet et qui sont les suivantes :  

 Zone (1) de minerai non magnétique inférieur contenant de la chamosite, sidérite, 

hématite, goethite, apatite et quartz. Et une teneur en fer de 54,6%. 

 Zone (2) de minerai magnétique, cette zone correspond à la zone dont le minerai est 

considéré comme économique et principal, ayant une teneur en fer de 57.8%, et 

contenant aussi de la magnétite, maghémite, chamosite, sidérite, hématite et de l'apatite. 

 Zone (3) de minerai non magnétique supérieur avec une teneur en fer de 53%, contenant 

aussi la goethite, chamosite, hématite, sidérite, et apatite. 
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Conclusion  

 

L’étude effectuée dans ce chapitre engendre la réalisation d’une bibliographie générale 

contenant les informations géologiques incluant les caractères lithologiques et la répartition 

spatiale des différentes roches rencontrées dans le secteur d’étude. Depuis le temps les 

géologues et géomorphologues s’intéressent  à comprendre par divers moyens les mécanismes 

et les processus qui génèrent les formations des terrains, plus largement leurs compositions 

lithologiques et lithostratigraphique.  

Dans le but d’améliorer les activités d’exploration des matières minérales et de 

contribuer ainsi au développement de l’économie, l’utilisation de moyens plus performants 

s’appuyant sur des concepts scientifiques évolués est nécessaire, d’où l’introduction de la 

télédétection qui constitue l’un des moyens les plus adaptés. Toutefois, son application dans le 

secteur minier nécessite la connaissance de certaines notions. 
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Introduction  

 

La télédétection désigne, dans son acception la plus large, la mesure ou l'acquisition 

d'informations sur un objet ou un phénomène, par l'intermédiaire d'un instrument de mesure 

n'ayant pas de contact avec l'objet étudié.  

 

Toutefois, en pratique, la télédétection est surtout utilisée pour les applications 

géospatiales, et concerne essentiellement les techniques mises en œuvre et l’utilisation à 

distance des systèmes (par exemple, d'un avion, d'un engin spatial, d'un satellite ou encore d'un 

bateau) permettant l'observation de la surface de la Terre, ou d'autres planètes. Ces systèmes 

nécessitent l'utilisation des capteurs qui exploitent essentiellement la mesure du rayonnement 

électromagnétique émis ou réfléchi par les objets.  

 

Les applications de la télédétection ont évolué au fil du temps dans tous les domaines : 

météorologie, climatologie, océanographie, cartographie, géographie, agriculture, 

environnement, etc. L'imagerie de télédétection s'est ainsi largement diffusée et vulgarisée.  
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1. Historique de la télédétection 
 

L’histoire de la télédétection est décrite en cinq grandes étapes (C. Kergomard) :  

 Débutant en dix-huit-cents cinquante-six jusqu’à la première guerre mondiale où pour 

la première fois on a installé à bord d’un ballon de manière fixe un appareil 

photographique.  

 De la première guerre mondiale à la fin des années cinquante où la photo aérienne 

devient un dispositif très important pour la cartographie, la recherche et la surveillance.  

 Au début des années dix-neuf cents cinquante-sept jusqu'à dix-neuf cent soixante-douze, 

on assiste à un début d’exploration de l’espace qui donna ainsi naissance à l’apparition 

de la télédétection moderne.  

 Ensuite à partir de dix-neuf cents soixante-douze, fut le lancement du premier satellite 

de télédétection des ressources terrestres appelé ERTS et qui a été renommé par la suite 

Landsat-1.  

 Enfin, depuis les années soixante-dix jusqu'à présent, un intérêt mondial a été accordé à 

la télédétection où on remarque un développement extraordinaire et continu tant 

exprimé par le lancement des satellites (Terra, LANDSAT, SPOT et autres), mais aussi 

par rapport aux capteurs et aux techniques de traitement. 

 

2. Notions de télédétection  
 

2.1. Définition générale de la télédétection 

 

La télédétection est définie comme étant l’ensemble des techniques, qui par l’acquisition 

de données ou d’images à distance, permettent d’obtenir des informations sur la surface terrestre 

par l’intermédiaire d’un instrument de mesure qu’on appelle capteur, et ce, sans contact direct 

avec l’objet étudié (S.C. Liew, 2001).  

 

La télédétection est une discipline qui regroupe l’ensemble des processus qui consiste à 

capter l’énergie par le biais des capteurs, cette énergie est définie par le rayonnement  

électromagnétique qui est émis ou réfléchi par l’objet, représentant ainsi un support qui réalise 

des activités d’observation, d’analyse et d’interprétation de  l’information en vue de la mettre 

en application. 

 

Ces processus se distinguent entre eux par les types de capteurs utilisés qui peuvent être 

embarqués à bord des avions,  navettes spatiales ou des plates-formes spatiales appelés 

satellites. Le mode d’acquisition peut être analogique ou numérique, actif ou passif. Il est 

également défini par la résolution spatiale, la gamme spectrale utilisée  ainsi que la surface 

observée (S.C.Liew, 2001 ; T.M. Lillsand et R.W. Kiefer, 1994).   

 

Dans la pratique, on utilise les données de la télédétection telles que des images collectées 

par des avions ou des satellites. Ces images satellites sont réelles et se définissent comme étant 
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une donnée numérique dont les différents paramètres peuvent être connus et pris pour une 

région déterminée de la surface de la terre. De nos jours, divers satellites permettent de procurer 

des images de la terre, où chaque satellite offre un ou plusieurs types d’images. 

 

Le choix d’une image satellite peut se faire suite à deux critères importants qui sont : sa 

résolution et sa gamme spectrale (contenu des bandes spectrales). En outre, il est nécessaire de 

définir le périmètre de couverture qu’il faut utiliser sur l’image. 

 

Pour générer une image, une mesure des rayonnements électromagnétiques est présentée 

en différentes bandes du spectre électromagnétique, l’objectif étant d’obtenir le plus 

d’informations en combinant ces bandes. L’intensité du rayonnement électromagnétique pour 

chaque bande est enregistrée numériquement pour des unités d’échantillonnage spatial qu’on 

appelle pixels (SEOS, 2015). 

 

L’application de la télédétection a vu son étendu dans plusieurs domaines, par exemple, 

l’évaluation des risques naturels comme les tremblements de terre et les inondations ; la gestion 

des ressources naturelles ; l’estimation d’impact des catastrophes naturelles. 

 

La télédétection est également utilisée dans l’évaluation des réserves géologiques et 

minérales, et c’est dans ce contexte que notre étude est proposée comme outil de support pour 

réaliser une prospection minière dans des régions données. 

 

2.2. Principe de fonctionnement  
 

Dans la plupart des cas, la télédétection implique une interaction entre l'énergie 

incidente et les cibles. Le processus de la télédétection comporte sept éléments que nous citons 

ci-dessous (A. Bourezg ; 2012) : 
  

2.2.1. La source d’énergie  

La source d’énergie est nécessaire pour illuminer la cible (objet étudié), dans deux types 

de télédétection : 

a. En télédétection passive 

Dans ce cas, les sources de rayonnement sont des sources naturelles (Terre, Soleil,…) 

et le capteur est un simple récepteur passif (exemples : Landsat, satellites SPOT, NOAA ou 

Météosat). 

b. En télédétection active 

Dans ce cas, la source de rayonnement est une source artificielle qui est embarquée à 

bord du satellite et l’émission se fait dans la direction des objets étudiés (les images radars en 

font partie). 

Donc, selon le cas, le rayonnement provient du soleil, des objets au sol, ou du satellite 

lui-même. 
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2.2.2. L’atmosphère  

Généralement, les capteurs reçoivent un rayonnement émis ou réémis par la Terre et 

l’atmosphère. Aussi, les particules atmosphériques (molécules gazeuses et aérosols) absorbent 

et/ou diffusent le rayonnement électromagnétique, ce qui crée un bruit indésirable dans les 

images de télédétection qu’il faut corriger dans plusieurs applications. 

 

2.2.3. La cible  

Une fois parvenue à la cible, l'énergie interagit avec la surface de celle-ci. La nature de 

cette interaction dépend des caractéristiques du rayonnement et des propriétés physico-

chimiques de la surface. 

Les différentes interactions sont donc : 

 

a. L’émission   

Tout corps dont la température diffère du zéro absolu émet un rayonnement 

électromagnétique propre et le spectre démission de ce rayonnement est caractéristique de sa 

température. Cette loi n’est vérifiée que pour le « corps noir », mais plusieurs milieux naturels, 

comme l’eau, ont un comportement proche de celui du corps noir. L’émission du corps noir 

dépend de sa température. Plus la température d’un corps est élevée, plus son maximum 

d’émission tend vers les courtes longueurs d’onde. En télédétection optique, l’émission vient 

du soleil qui rayonne dans le visible, le proche infrarouge et le moye infrarouge en raison de sa 

température générée par des réactions thermonucléaires. 

 

b. La réflexion  

Dans le cas de la réflexion, les rayonnements sont réfléchis et renvoyés vers l’espace. 

Généralement, la réflexion est diffuse, c’est-à-dire qu’elle se fait dans toutes les directions, mais 

elle peut comporter une composante spéculaire, comme celle observée sur un miroir d’eau 

calme. 

 

c. L’absorption  

Celle-ci représente la capacité d’un corps à ne pas réfléchir les rayonnements qu’il 

reçoit. Tout corps absorbant des rayonnements tend à s’échauffer. 

 

2.2.4. Le capteur et l’enregistrement de l’énergie 

Une fois l'énergie diffusée ou émise par la cible, elle doit être captée à distance (par un 

capteur qui n'est pas en contact avec la cible) pour être enfin enregistrée et transmise aux 

stations de réception terrestres. Le capteur constitue un instrument d’acquisition d’images 

d’observation de la Terre, souvent à bord des satellites, qui sont des objets gravitant autour de 

la Terre grâce à l’équilibre entre la force de gravitation et la force centrifuge. Selon les 

conditions, la trajectoire d’un satellite est soit un cercle, soit une ellipse.  

 

2.2.5. Transmission, réception et traitement  

L'énergie enregistrée par le capteur et convertie en données numériques est transmise, 

souvent par des antennes de télémétrie, à une station de réception où l'information est 
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transformée en images numériques fournies aux utilisateurs par différents moyens (ex. : 

serveurs nuagiques). 

2.2.6. Interprétation et analyse  

Durant cette étape, l’image enregistrée par les capteurs et traitée nécessite une 

interprétation visuelle et/ou numérique afin d’obtenir l’information voulue concernant la cible. 

 

2.2.7. Application   

La dernière étape du processus consiste à utiliser l'information extraite de l'image pour 

mieux comprendre la cible, découvrir de nouveaux aspects relatifs aux phénomènes étudiés et 

aider à résoudre un problème particulier. 

Figure 2.1 : Etapes du processus de traitement par télédétection (N. Boudali, 2012) 

 

2.3. Bases physiques de la télédétection  

 

L’élément principal qui permet de réaliser le processus de la télédétection est le capteur 

qui se définie comme étant un organe très sensible faisant objet d’un radiomètre imageur 

mesurant ainsi des rayonnements électromagnétiques qui par la suite sont organisés et structurés 

sous forme d’une image (L. Polidori). 

Les images enregistrées et obtenues sont une source d’informations des objets qu’elles 

représentent. Toutefois, cette représentation se définie par le rayonnement électromagnétique 

émis ou réfléchi qui lie entre l’image et l’objet. Bien entendu, la définition de base de la 

télédétection repose en premier lieu sur la connaissance du comportement et du contact des 

rayonnements électromagnétiques avec la surface de la terre à travers l’atmosphère. Cependant, 

la possibilité de mettre une équation rigoureuse qui permet de calculer les résultats de la 

télédétection est compliquée à effectuer, et ce, en raison de la complexité de l’image liée à la 
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nature du terrain ainsi que l’atmosphère de la région d’étude. De ce fait, l’analyse dans une 

majeure partie de la télédétection s’appuie sur l’expérience, les images de références et 

l’intuition d’interprétation de l’image (N. Boudali, 2012). 

 

2.3.1. Rayonnement électromagnétique 

Le rayonnement électromagnétique se définit par deux théories, la première dite théorie 

corpusculaire de la lumière qui considère que le rayonnement est un flux de particules 

élémentaires (photons), la deuxième dite théorie ondulatoire qui définit le rayonnement 

électromagnétique comme une composition de deux vecteurs perpendiculaires entre eux, se 

déplaçant à la vitesse de la lumière, ces deux vecteurs sont le champ électrique et le champ 

magnétique (K. Soudani, 2005). 

Les ondes électromagnétiques sont soit : naturelles (produites par la Terre et par chaque 

être vivant), soit artificielles (produites par des appareils). Chaque onde électromagnétique a 

une fréquence, une longueur et une puissance qui lui sont propres. La fréquence se mesure en 

hertz, la longueur d’ondes en mètres, et la puissance en watt. La longueur d’ondes est d’autant 

plus petite que la fréquence est élevée, il y a donc un rapport inversement proportionnel entre 

ces deux notions.  

 
Figure 2.2 : Une onde électromagnétique (Nicolas, 2015) 

 

En revanche la puissance de propagation de l’onde augmente si la fréquence est plus grande, de 

ce fait les ondes électromagnétiques sont classées en fonction de leur fréquence en : 

 

a. Rayonnements ionisants  

Ils englobent les ondes à très haute fréquence. Il s’agit des UV, des rayons X, des rayons 

gamma et des rayons cosmiques. Ceux-ci se situent au-delà du spectre visible. Ces ondes sont 

dangereuses, car elles ont la capacité de rompre la composition des atomes. 

 

b. Rayonnements non-ionisants 

On retrouve les ondes radio, les micro-ondes, l’infrarouge, le proche ultraviolet et la 

lumière visible.  
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2.3.2. Bandes spectrales (spectre électromagnétique)  

Le spectre électromagnétique représente la répartition de l'ensemble des rayonnements 

électromagnétiques classés selon ses différentes composantes en termes de fréquence, d'énergie 

des photons ou encore de longueur d'onde associée. Le spectre électromagnétique s'étend 

théoriquement de zéro à l'infini en fréquence (ou en longueur d'onde), de façon continue. Pour 

des raisons tant historiques que physiques, on le divise en plusieurs grandes classes de 

rayonnement, qui s'étudient par des moyens particuliers à chacune d'entre elles. En partant des 

ondes les plus énergétiques, on distingue successivement (UVED, 2008) : 

 

a. Les rayons gamma (γ)  

 Ils sont dus aux radiations émises par les éléments radioactifs. Très énergétiques, ils traversent 

facilement la matière et sont très dangereux pour les cellules vivantes. 

Leurs longueurs d’onde s'étendent d’un centième de milliardième (10-14 m) à un milliardième 

(10-12 m) de millimètre. 

 

b. Les rayons X  

C’est des rayonnements très énergétiques traversant plus ou moins facilement les corps 

matériels et un peu moins nocifs que les rayons gamma, ils sont utilisés notamment en médecine 

pour les radiographies, dans l'industrie (contrôle des bagages dans le transport aérien), et dans 

la recherche pour l'étude de la matière (rayonnement synchrotron). 

Les rayons X ont des longueurs d’onde comprises entre un milliardième (10-12 m) et un cent 

millième (10-8 m) de millimètre. 

 

c. Les ultraviolets  

Ce sont des rayonnements qui restent assez énergétiques, ils sont nocifs pour la peau. 

Heureusement pour nous, une grande part des ultraviolets est stoppée par l'ozone atmosphérique 

qui sert de bouclier protecteur des cellules.  

Leurs longueurs d’onde s’échelonnent d’un cent millième (10-8 m) à quatre dixièmes de 

millième (4.10-7 m) de millimètre. 

 

d. Le domaine visible  

Ce domaine correspond à la partie étroite du spectre électromagnétique perceptible par 

notre œil. C’est dans le domaine visible que le rayonnement solaire atteint son maximum (0,5 

μm) et c’est également dans cette portion du spectre que l’on peut distinguer l’ensemble des 

couleurs de l’arc en ciel, du bleu au rouge. 

 Il s’étend de quatre dixièmes de micromètre (0.4 μm) -  lumière bleue  - à huit dixièmes de 

micromètre (0.8 μm) de millimètre -  lumière rouge. 

 

e. L’infrarouge   

 La gamme des infrarouges qui est composée du proche infrarouge (PIR), du moyen 

infrarouge (MIR) et de l’infrarouge thermique, couvre les longueurs d’onde allant de huit 

dixièmes de micromètre (0.8 μm) à un millimètre (1 mm). 
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f. Les ondes radar ou hyperfréquences   

Cette région du spectre est utilisée pour mesurer le rayonnement émis par la surface 

terrestre à l’aide de capteurs passifs ou rétrodiffusés par celles-ci (dans le cas des capteurs radar 

actifs).Le domaine des hyperfréquences s’étend des longueurs d’onde de l’ordre du centimètre 

jusqu’au mètre. 

 

g. Les ondes radio  

Ce domaine de longueurs d'ondes est le plus vaste du spectre électromagnétique et 

concerne les ondes qui ont les plus basses fréquences. Il s'étend des longueurs d'onde de 

quelques cm à plusieurs Km. 

 

Relativement faciles à émettre et à recevoir, les ondes radio sont utilisées pour la 

transmission de l'information (radio, télévision et téléphone). La bande FM des postes de radio 

correspond à des longueurs d’onde de l’ordre du mètre. Celles utilisées pour les téléphones 

cellulaires sont de l'ordre de 10 cm environ. Contrairement à l'œil humain qui n’est capable de 

capter le rayonnement que dans une fenêtre très étroite du spectre électromagnétique, celle 

correspondant au domaine du visible (longueurs d'ondes comprises entre 0,4μm et 0,7μm), les 

capteurs satellitaires utilisent une fraction beaucoup plus étendue du spectre (Minoprof, 2016).  

Figure 2.3 : Le spectre électromagnétique (Fournil, 2017) 

 

2.3.3. Notions de réflectance et de signatures spectrales 

 

a. Interaction du rayonnement électromagnétique à la surface terrestre  

L’incidence du rayonnement électromagnétique induit une énergie qui est soit 

absorbée, transmise ou réfléchie par un élément de la surface terrestre (BRGM/RP 60227-FR., 2011). 

Le principe de la conservation de l’énergie admet que l’énergie incidente totale (E) 

pour une longueur d’onde donnée () est égale à la somme des énergies réfléchie, absorbée et 

transmise (BRGM/RP 60227-FR., 2011). 
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De ce fait, la réflectance pour une longueur d’onde donnée est définie par le rapport de 

l’énergie réfléchie d’une surface à l’énergie incidente totale reçue par la même surface 

(BRGM/RP 60227-FR., 2011). La réflectance symbolise une grandeur sans unité allant de 0 jusqu’à 

1 ou de 0 jusqu'à 100 en pourcentage (BRGM/RP 60227-FR., 2011). 

 

b. Signature spectrale   

Un certain nombre de principaux matériaux du globe terrestre dont la végétation, l’eau 

(même sous sa forme cristallisée glace ou neige), les roches et les sols (disposition de minéraux) 

sont susceptibles de réfléchir la lumière solaire vers les satellites opérant dans le domaine de la 

télédétection (UVED, 2008), (BRGM/RP 60227-FR., 2011).   

En mesurant l'énergie réfléchie par une cible en fonction de la variation de la longueur 

d'onde, on obtient une mesure qu’on définit par un spectre de réflectance spécifique ou signature 

spectrale de cette cible (BRGM/RP 60227-FR, 2011). De ce fait la signature spectrale symbolise une 

réponse radiométrique des objets qu’on représente par une courbe ayant comme ordonnée la 

réflectance et en abscisse la longueur d’onde (C. Gomez et al, 2005) .Toutefois l’obtention de la 

signature se fait soit par modèle théorique qu’on appelle simulation, ou par mesures réelles, 

donc en laboratoire (résultats des manipulations du spectrophotomètre). 

 

Figure 2.4 : Signature spectrales des surfaces naturelles (BRGM/RP 60227-FR, 2011) 

 

Suivant la figure 2.4, on peut définir les caractéristiques de la signature spectrale qui sont les 

pics d’absorption et la longueur d’onde (position). 
 

Principalement à partir des caractéristiques de la signature spectrale, on réalise une 

analyse sur la composition des objets, et ce, par le biais de la forme et la symétrie des pics 

d’absorption, de plus, à partir des profondeurs de ces pics, on obtient une information 

quantitative sur les matériaux présents (BRGM/RP 60227-FR., 2011).  
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Plus clairement, l’intensité de la réflexion du sol dépend de la composition chimique 

des matériaux réflecteurs, la morphologie de la surface et la micromorphologie de la même 

surface (C. Gomez et al, 2005). De ce fait, on déduit que la réflectance des roches dépend d’un coté 

de leur composition de l’autre de leur degré d’altération. 

On trouve ci-dessous, certaines figures représentant les signatures spectrales de certains 

minéraux.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2.5c : Identification spectrale des oxyde de Fer (BRGM/RP 60227-FR, 2011) 

Figure 2.5a : Identification spectrale des 

carbonates (BRGM/RP 60227-FR, 2011) 

Figure 2.5b : Identification spectrale des 

argiles et micas (BRGM/RP 60227-FR 2011) 
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2.4.  Le système d’acquisition  
 

En télédétection, un système d’acquisition est composé d’un outil principal qu’on 

appelle capteur, ce dernier est monté sur un vecteur ou une plateforme (satellite), et permet 

d’obtenir par la suite un résultat appelé image satellitaire (S. Ghardaoui et W. Benhabib, 2008). 

 

2.4.1. Les Satellites 
  

Le satellite nommé aussi vecteur, est une plateforme équipée de dispositifs 

électroniques, tels que les capteurs photoélectriques ou les cameras à haute résolution. Ce 

vecteur est parfait pour effectuer des observations sur la terre. Dans sa composition interne, le 

satellite comporte deux unités, la première, correspond à la plateforme, elle sert d’ailleurs à 

maintenir une ou plusieurs charges utiles, quant à la deuxième, elle représente cette charge utile 

qui correspond à un groupe d’éléments permettant de réaliser une fonction de télédétection (S. 

Ghardaoui et W. Benhabib, 2008). 
 

A cet effet, on distingue selon la figure deux types de satellites :  

 
Figure 2.6 : Types de satellites (N. Boudali, 2012) 

 
 

a. Les satellites géostationnaires  

Avec une altitude de 36.000 km, ils ont une caractéristique principale qui est d’assurer 

une surveillance en forme continue d’une même partie de la sphère terrestre, de plus, leur vitesse 

angulaire est la même que la vitesse de rotation de la terre, de ce fait, et en tant qu’observateur 

terrestre, on les aperçoit comme immobiles, à titre d’exemple, on a les satellites GOES et 

METEOSAT.  

b. Satellites à défilement  

Correspondent à des satellites qui sont considérés comme étant mobiles par rapport à la 

sphère terrestre, ils sont caractérisés par une altitude oscillant entre 800 et 200 km, tout en 

décrivant des orbites circulaires, et ils peuvent garantir une observation sur un même point mais 

deux fois en vingt-quatre heures,  et nécessitant environ cent minutes pour faire le tour complet 

autour de la Terre ; on cite parmi ces satellites  SPOT et Landsat. 
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2.4.2. Les Capteurs  

Par définition, un capteur représente un instrument électronique qui enregistre, ensuite 

transforme, dans une série de longueurs d’ondes, un rayonnement électromagnétique en un 

signal électronique, ensuite ce signal est codé afin de devenir un compte numérique (S. Ghardaoui 

et W. Benhabib, 2008).Le capteur est caractérisé par les propriétés qui définissent ses performances, 

ces propriétés sont les suivantes :   

 

a. La résolution spatiale  

Elle représente la dimension et la valeur d’observation du point élémentaire connu sous 

le nom de Pixel (Picture and elements), cependant, une résolution peut avoir 600 points au 

minimum par pouce. 

 

b. La résolution spectrale 

Elle se définit par l’aptitude du capteur de différencier entre les signaux des diverses 

longueurs d’ondes et est matérialisée par le nombre de bandes spectrales. 

 

c. La résolution radiométrique  

Elle indique la capacité du capteur à distinguer, dans une bande spectrale, les différents 

signaux électromagnétiques des différentes énergies générée par des différences de réflectance 

des surfaces visées. 

 

d. La résolution temporelle  

L’acquisition d’une image par le système d’un même point de la Terre, se fait par le 

biais d’une fréquence qu’on appelle résolution temporelle 

Selon la source d’énergie, les capteurs sont décomposés en deux types (Ghar, 2008) : 

a. Les capteurs passifs  

Ils sont en relation directe avec les sources naturelles telles que le soleil, et ils réalisent 

aussi des mesures de l’énergie (émise ou réfléchie) par les surfaces au sol et l’atmosphère.  

 

b. Les capteurs actifs  

Ils sont caractérisés par la production de leur propre énergie pour illuminer la cible, ils 

dégagent un REM qui est perçu, mesuré (principalement les capteurs radar et lidar).  

La majorité des satellites prennent à l’aide de leurs capteurs des images de la Terre, introduisant 

ainsi une image à format numérique qu’on appelle image satellitaire.  

 

2.4.3. Les images satellitaires 
 

Quels que soient les dispositifs de télédétection utilisés pour capter et enregistrer les 

rayons électromagnétiques, on obtient toujours un résultat sous forme de représentation 

graphique qu’on appelle image satellitaire. Mathématiquement, l’image satellitaires est une 

fonction F(x, y) à deux variables entières x et y qui symbolisent la ligne et la colonne 

respectivement (S. Ghardaoui et W. Benhabib, 2008). 
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L’existence de plusieurs types de capteurs en télédétection, implique l’obtention de 

plusieurs images qui se différencient en termes de caractéristiques. De ce fait, on distingue deux 

ensembles d’images :  

 

a. L’image optique  

Ce sont des images acquises par des capteurs passifs qui, mesurent l’énergie réfléchie 

ou émise par une source externe, tels que certains de ces capteurs, mesurent l’énergie réfléchie 

du soleil activée dans les trois domaines  Visible, PIR et MIR. Cependant, d’autres capteurs 

travaillent dans le domaine thermique pour mesurer l’énergie émise par la Terre elle-même (O.C. 

Viveros, 2003).  
 

L’image optique se divise en trois sous-ensembles :   

 

 L’image panchromatique  

C’est une matrice de pixels, où chaque pixel est attribué une valeur correspondant à une 

intensité lumineuse représentée par une palette de couleurs. Cependant, si l’image est 

monochromatique, l’intensité lumineuse est définie par la gamme du gris allant du noir pour la 

plus faible intensité jusqu'au blanc pour la plus forte intensité (I. Boukrech, 2006).  

 

 L’image multi-spectrale (multi-bandes)  

Contrairement à l’image panchromatique, l’image en couleurs, est un vecteur à trois valeurs 

associé à chaque pixel, tel que ce vecteur est représenté dans le mode RVB (Rouge, Vert, Bleu). 

On parle d’images multi-spectrales lorsque le vecteur de valeurs associé à un pixel est au moins 

de dimension deux. Par exemple, les satellites d’observation de la Terre PLEIADES permettent 

l’acquisition d’images multispectrales avec les 4 bandes spectrales B0 à B3 dans le bleu, le vert, 

le rouge et le proche infrarouge. De plus la multiplication du nombre de bandes spectrales 

permet de distinguer la nature des objets observés (I. Boukrech, 2006).  

 

 L’image hyperspectrale  

On parle généralement d’images Hyper-spectrale, lorsque le nombre de bandes spectrales est 

supérieur à la centaine, ou lorsque l’ensemble des bandes spectrales acquises est continu, à titre 

d’exemple, Hypérion fut le premier capteur hyper-spectral lancé à bord du satellite EO-1 

permettant d’acquérir 220 bandes comprise entre 400 et 2500 nm (E. Christophe, 2005). 

 

b. L’image Radar  

L’image radar représente une image obtenue par des capteurs actifs (émetteurs et 

récepteurs), qui envoient un signal électromagnétique pour illuminer le terrain, d’où l’écho de 

la cible est par la suite détecté, mesuré et chronomètré (E. Christophe, 2005).  

 

3. Application dans le domaine minier 
  

Les images de télédétection peuvent être utilisées dans toutes les phases du cycle minier, 

lors de la prospection et l'exploration, l'extraction ainsi que la réhabilitation de mines. Bien que 
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l'arpentage des sols continue à être utilisé dans les opérations minières, la disponibilité étendue 

d'images provenant de satellites spatiaux ainsi que de plates-formes aéroportées a entraîné une 

augmentation significative de l'utilisation des images de télédétection. 

La contribution de la télédétection dans chaque phase du cycle minier :  

 

3.1. Prospection et exploration 

  

Il s’agit de la recherche de gisements, qui repose sur différents types de données 

(photographies aériennes, images satellitaires, précédents miniers, géologiques, géophysiques, 

géochimiques, économiques, etc.). Une fois qu'un corps minéralisé est découvert, l'exploration 

est entamée pour évaluer qualitativement et quantitativement les ressources minérales, afin de 

définir la faisabilité technique et économique de l'exploitation d'un gisement. Cela se fait par 

des opérations minières de surface  et des travaux souterrains qui permettent de reconnaître le 

corps minéralisé dans ses trois dimensions et c’est ici où la télédétection offre un nouvel outil 

pour explorer de plus grandes zones et se concentrer sur les détections lithologiques clés et les  

interprétations des structures géologiques et hydrogéologiques pour évaluer l'emplacement de 

gisements minéraux potentiels, mais aussi afin de réduire les coûts d'exploration et d'accroître 

le développement. 

 

3.2. Exploitation 

  

Cette phase commence lorsque les travaux pour la production minière commencent. Il 

existe de nombreuses méthodes d'exploitation différentes qui dépendent de l'état physique du 

minéral, de la profondeur, de la forme et d'autres caractéristiques. 

Au cours de l’exploitation, la télédétection peut être utilisée pour détecter des mouvements de 

terrain subtils, ce qui est essentiel pour la protection des infrastructures. En outre, en utilisant 

des images multi-spectrales et chronologiques, on obtient des cartes topographiques et 

d’occupation du sol mais, il est possible aussi d’examiner les changements d’utilisation des sols 

et les incidences sur l’environnement et de mettre en œuvre des mesures de remise en état. 

 

3.3. Fermeture et réhabilitation 

 

Après l’épuisement du gisement et la fin de l’exploitation, la phase de réhabilitation et 

de fermeture de la mine vient compléter le cycle de l’exploitation minière. Cette phase consiste 

en la remise en forme des terrains, la mise en place d’une pépinière sur le site pour produire les 

plants nécessaire à la reforestation, l’enherbement qui permet d’éviter l’érosion et d’améliorer 

la structure et la fertilité des sols et enfin, la reforestation qui permettra de favoriser la clôture 

naturelle du milieu. La télédétection peut ainsi jouer un rôle important durant cette phase, et ce 

en localisant et en surveillant les déplacements de terrain (affaissement et soulèvement), les 

zones polluées et la végétation dans le but de minimiser les impacts environnementaux. 
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Conclusion  

La télédétection couvre un grand champ d'applications qui satisfont de nombreux 

besoins, aussi bien pour les utilisateurs institutionnels que pour des acteurs privés. Elle offre 

des solutions qui sont souvent plus économiques que des moyens plus traditionnels ou qui 

bénéficient d'une intégrité, d'une objectivité qui en font un arbitre impartial. De plus, dans un 

certain nombre de cas, la télédétection reste la seule méthode pour traiter des problèmes qui ne 

peuvent être résolus par des moyens classiques. 

Dans le secteur minier, la télédétection voit son essor ces dernières années et trouve ses 

meilleures applications en géomorphologie et en géologie. Ainsi, une exploration qui identifie 

et distingue entre les différents types de roche et leurs lithologies dans une région donnée, 

implique l’application de tout un processus incluant divers méthodes et outils afin d’obtenir un 

résultat considéré comme étant la base préliminaire des travaux de prospections minière. 
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Introduction  
Le présent chapitre présente les différentes approches extraites de plusieurs cas d’études 

et de recherches traitant l’utilité des techniques de télédétection en relation avec la cartographie 

géologique régionale, la cartographie des gisements potentiellement exploitables et des surfaces 

lithologiques, mais aussi en relation directe et indirecte avec les phases de prospection, 

exploration et les travaux d’exploitation minière. 
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1. Approche méthodologique  
 

Il s’agit de présenter une synthèse bibliographique basée sur une évaluation approfondie 

de nombreux articles, décrivant le processus de traitement des données satellites adopté dans le 

but d’extraire des informations utiles pour la caractérisation des sites d’étude et d’obtenir des 

résultats de façon instantanée ayant une valeur significative dans l’optique de contribuer au projet 

d’exploration et d’industrie minière. Ce processus comprend des étapes nécessaires dont la 

collecte des données, les opérations de traitement et d’analyse et la comparaison avec les données 

réelles du terrain pour évaluer l’efficacité des différentes techniques adoptées pour le traitement 

d’images permettant une meilleure détection des surfaces de roches encaissantes minéralisées et 

une bonne discrimination des lithologies. 

 

1.1.  Etapes de développement  

  

La télédétection correspond à l’ensemble des connaissances et techniques qui de nos jours 

est érigé en une discipline scientifique faisant office d’une spécialité de recherche permettant de 

déterminer certaines caractéristiques physiques et biologiques de points observés à la surface de 

la Terre, elle est fondée sur de nombreuses compétences et technologies appliquées à 

l’observation, l’analyse et l’interprétation de divers phénomènes. Ses sources fondamentales sont 

les équipements ou appareillages, les mesures et les images ou scènes extraites à partir de 

plateformes aériennes et spatiales. L’extraction d’informations à partir des images recueillies se 

fait selon un processus de traitement incluant diverses méthodes se basant sur les caractéristiques 

du site d’étude. 

 

Dans ce qui suit, nous allons essayer de donner un aperçu général décrivant les outils de 

collecte d’images, les logiciels de traitement utilisés et les différentes méthodes et techniques de 

traitement et d’analyse habituellement appliquées à la cartographie géologique, pédologique et 

géomorphologique. 

 

1.1.1. Collecte de données et matériel utilisé 

a. Données 

La réalisation du traitement d’images nécessite avant tout une collecte de données à partir 

des supports de cartes géologiques de la zone d’étude, les images satellites et éventuellement les 

échantillons prélevés sur le terrain. Cette étape représente la phase préliminaire avant le choix de 

la technique de traitement adéquate à adopter, selon le site d’étude et la nature des minéraux 

recherchés constituant l’objet de détection. 

 

b. Matériel 

L’ensemble de scènes ou images utilisées pour la suite des étapes est collecté à partir des 

capteurs embarqués à bord des satellites, sera traité à l’aide de logiciels adaptés. Cependant, les 

principaux satellites en rapport avec leurs capteurs sont : 
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 Les satellites  

- Landsat 

Landsat a été créé par la collaboration entre l’U.S. Geological Survey (USGS) et de la 

National Aeronautics and Space Administration (NASA), il a été lancé en 1972, et 

depuis, d’autres satellites ont été lancés avec succès. 

Les lancements de Landsat 2, Landsat 3, Landsat 4, Landsat 5, Landsat 7 et Landsat 8 

se sont produits en 1975, 1978 et 1982, 1984, 1999 et 2013 respectivement ; ces derniers 

sont caractérisés par une largeur de piste de 183 km et des orbites répétitives, circulaires, 

héliosynchrones, quasi polaires, permettant d’avoir une couverture complète entre 81°N 

et 81°S. Cependant, Landsat 6 n’a pas réussi à atteindre son orbite en 1993 et Landsat 9 

devrait être lancé en 2020. 

Les satellites Landsat collectent des images spatiales du globe terrestre, fournissant des 

données nécessaires et applicables dans divers domaines, dont la foresterie, l'agriculture, 

la géologie et la planification régionale. 

Le pouvoir de détection et de quantification des variations environnementales de la 

Terre dépend des capteurs ayant la capacité de procurer des mesures précises et 

cohérentes des caractéristiques spatiotemporelles. 

Les principaux capteurs sont : 

Les capteurs TM 

Le capteur Landsat Thematic Mapper (TM) a été embarqué dans Landsat 4 et Landsat 

5, procurant des images comportant six bandes spectrales d’une résolution spatiale de 

30 m pour les bandes 1 à 5 et 7, et de 120 m pour la bande thermique (bande 6). Le 

capteur TM comprend un système d'étalonnage embarqué et procure des scènes de 

dimensions 170 km Nord-Sud sur 183 km Est-Ouest. 

 

Tableau 3.1 : Caractéristiques du capteur TM (EOSAT, 1995) 

 

Landsat 4-5 

Thematic 

Mapper 

(TM) 

Bandes 
Longueurs 

d’ondes (μm) 

Résolution  

(m) 

Bande 1 - Bleue 0.45 - 0.52 30 

Bande 2 - Verte 0.52 - 0.60 30 

Bande 3 - Rouge 0.63 - 0.69 30 

Bande 4 - Proche Infrarouge (PIR) 0.76 - 0.90 30 

Bande 5 - Infrarouge courtes   

             longueurs d’ondes (IRCL) 1 
1.55 - 1.75 30 

Bande 6 - Thermique 10.40 -12.50 120* (30) 

Bande 7 - Infrarouge courtes longueurs 

d’ondes (IRCL) 2 
2.08 -2.35 30 

*L’acquisition de la bande 6 se fait à une résolution de 120 m, tandis que les produits sont 

rééchantillonés à 30 m de pixel 

Le capteur ETM+ 

Le capteur ETM+ (Enhanced Thematic Mapper Plus) de Landsat est installé sur 

Landsat 7, et les images fournies comportent sept bandes spectrales telles que la bande 

panchromatique (bande 8) possède une résolution spatiale de 15 m, tandis que les bandes 
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1-5 et 7 ont une résolution spatiale de 30 m. La taille de la scène obtenue est similaire à 

celle du capteur TM. 

Le capteur ETM+ a été étalonné par procuration à l’aide de cibles terrestres et par 

recoupement à l’aide de nombreux capteurs et possède aussi trois systèmes d’étalonnage 

embarqués pour les bandes réfléchissantes. 

 

Tableau 3.2 : Caractéristiques du capteur ETM+ (EOSAT, 1995) 

 

Landsat 7 

Enhanced 

Thematic 

Mapper 

Plus  

(ETM+) 

Bandes 
Longueurs d’ondes 

(μm) 

Résolution 

(m) 

Bande 1 - Bleue 0.45 - 0.52 30 

Bande 2 - Verte 0.52 - 0.60 30 

Bande 3 - Rouge 0.63 - 0.69 30 

Bande 4 - Proche Infrarouge 

(PIR) 
0.77 - 0.90 30 

Bande 5 - Infrarouge courtes      

    longueurs d’ondes (IRCL) 1 
1.55 -1.75 30 

Bande 6 - Thermique 10.40 -12.50 60 * (30) 

Bande 7 - Infrarouge courtes  

    longueurs d’ondes (IRCL) 2 
2.09 -2.35 30 

Bande 8 - Panchromatique 0.52 - 0.90 15 

*L’acquisition de la bande 6 se fait à une résolution de 60 m, tandis que les produits sont 

rééchantillonés à 30 m de pixels. 

 

Les capteurs OLI et TIRS 

L'Imageur Terrestre Opérationnel (OLI) et le Capteur Infrarouge Thermique (TIRS) 

embarqués dans Landsat 8 contiennent neuf bandes spectrales ayant une résolution 

spatiale de 30 m pour les bandes 1 à 7 et 9, par contre, la bande 8 (panchromatique) a 

une résolution de 15 m, et les bandes thermiques 10 et 11  sont collectées à 100 mètres. 

Les dimensions des scènes sont les mêmes que celles de TM et ETM+. L'OLI dispose 

de deux dispositifs d'étalonnage radiométrique embarqués, en plus de ses calibreurs 

embarqués, OLI a la capacité de recueillir des observations lunaires et stellaires à des 

fins d'étalonnage. 
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Tableau 3.3 : Caractéristiques des capteurs OLI et TIRS (EOSAT, 1995) 

 

 

Landsat 8 

Operational 

Land Imager 

(OLI)  

and 

Thermal 

Infrared 

Sensor 

(TIRS) 

 

 

Bandes 
Longueurs 

d’ondes (μm) 

Résolution 

(m) 

Bande 1 - Ultra Bleue   

                        (côtière/aérosol) 
0.435 - 0.451 30 

Bande 2 - Bleue 0.452 - 0.512 30 

Bande 3 - Verte 0.533 - 0.590 30 

Bande 4 - Rouge 0.636 - 0.673 30 

Bande 5 - Proche Infrarouge  

                             (PIR) 
0.851 - 0.879 30 

Bande 6 - Infrarouge courtes  

         longueurs d’ondes (IRCL) 1 
1.566 - 1.651 30 

Bande 7 - Infrarouge courtes                                      

longueurs d’ondes (IRCL) 2 
2.107 - 2.294 30 

Bande 8 - Panchromatique 0.503 - 0.676 15 

Bande 9 - Cirrus 1.363 - 1.384 30 

Bande 10 – Infrarouge  

                       thermique (TIRS) 1 
10.60 - 11.19 100 * (30) 

Bande 11 – Infrarouge    

                       thermique (TIRS) 2 
11.50 - 12.51 100 * (30) 

*L’acquisition des bandes 10 et 11 se fait à une résolution de 100 m, tandis que les produits 

sont rééchantillonés à 30 m de pixels. 

- Terra 

Terra représente un projet de collaboration entre les États-Unis, l'Union européenne, le 

Japon et le Canada. Lancé le 18 décembre 1999, le satellite orbite au autour de la Terre, 

pratiquement d’un pôle à l’autre en direction perpendiculaire à la direction de la rotation 

de la terre. 

Terra est caractérisé par une charge utile de cinq capteurs qui permettent de recueillir 

un ensemble de données globales représentant une base importante pour la recherche 

scientifique ce qui nous permet de comprendre tous les phénomènes se produisant dans 

notre planète. 

Les principaux capteurs de ce satellite sont : 

ASTER 

Le Radiomètre Spatial Avancé d’Emission et de Réflexion Thermiques (ASTER), est un 

capteur sous forme d’une caméra numérique essentielle permettant de capter des images 

de dimension 60 sur 60 km et collecter les données dans les deux domaines du visible 

et infrarouge. Ce capteur est utilisé dans le but de l’obtention d’informations importantes 

sur la surface de la terre particulièrement la température, l’émissivité, la réflectance et 

l’élévation. 
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Avec une caractéristique importante qui est la haute résolution spatiale de 15 à 90 m, 

ASTER regroupe 14 bandes spectrales, allant du visible jusqu'à l’infrarouge thermique 

procurant ainsi suivant la méthode de balayage transversal et un délai d’observation de 

16 jours des images précises. Ce capteur est surtout utilisé pour détecter les changements 

durant l’utilisation du sol, les exercices de cartographie, l’état de la couverture végétale 

et aussi pour la surveillance de l’environnement régional (Net 1). 

 

Tableau 3.4 : Caractéristiques d’ASTER (M. Abrams et S. Hook, 2002) 
 

Paramètre Bande VPIR Bande IRCL Bande IRT 

 

 

Longueur 

d’onde en 

µm 

1 0.52 - 0.60 4 1.600 -1.700 10 8.125 - 

8.475 

2 0.63 - 0.69 5 2.145-2.185 11 8.475 - 

8.825 

3N 0.76 - 0.86 6 2.185 - 2.225 12 8.925 - 

9.275 

3B 0.76 - 0.86 7 2.235 - 2.285 13 10.25 - 

10.95 

Capacité de stéréogramme 

en balayage longitudinal 

8 2.295 - 2.365 14 10.95 - 

11.65 

9 2.360 - 2.430   

Résolution 

au sol 

15 m 30 m 90 m 

 

CERES 

Le Cloud and the Earths Radiant Energy System est un capteur qui joue le rôle d’un 

mesureur de bilan radiatif de la Terre et le rayonnement atmosphérique pour fournir des 

évaluations sur les propriétés des nuages. 

 

MISR 

Le Multi-angle Imaging Spectro Radiometer est un capteur qui réalise des observations 

multidirectionnelles dans des angles différents d’où la possibilité d'obtenir des mesures 

de la réflectance des nuages et de la surface mais aussi des cartes globales des propriétés 

de la surface, des aérosols et de la végétation. 

Il est composé de neuf caméras possédant chacune quatre bandes à 0,446 µm, 0,558 µm, 

0,672 µm et 0,866 µm, ce qui permet de prendre des images dans la région du visible 

sous neuf angles de vue différents dans un cycle répétitif de neuf jours avec une 

résolution de 275, 550 ou 1,1 km. 
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MODIS 

Le capteur Moderate-Resolution Imaging Spectroradiometer est un radiomètre 

multispectral à balayage transversal fonctionnant dans le domaine visible par le biais de 

l'infrarouge thermique. 

Avec un fonctionnement tous les 1 à 2 jours avec 36 bandes spectrales dont deux ont 

une résolution de 250 m, cinq de 500 m et vingt-neuf de 1 km. MODIS a été conçu par 

une large couverture spectrale et un bon cycle de répétition afin de contribuer dans la 

compréhension globale du système terrestre (Net 2). 

 

MOPITT 

Le Measurements Of Pollution In The Troposphere, est un scanner avec une résolution spatiale 

de 22 km qui, utilise la spectroscopie de corrélation gazeuse pour collecter des données 

concernant la mesure du méthane et du monoxyde de carbone dans l'atmosphère. 

 

 Les logiciels 

Il est nécessaire de disposer de logiciels de pointe pour traiter efficacement ces données. Voici 

quelques exemples :  

 

- ArcGIS 

C’est un système constitué d’une série de logiciels, considéré comme l’une des 

principales plateformes de développement et d'utilisation des systèmes d'informations 

géographiques (SIG). Développé par la société américaine Esri (Environmental Systems 

Research Institute, Inc). Il représente une infrastructure composée de plusieurs outils 

permettant de collecter, combiner, gérer et compiler des données géographiques afin 

créer des cartes conduisant ainsi à expliquer un phénomène donné. ArcGIS contribue 

fortement à l’amélioration de la visualisation, l’analyse et le traitement d’images. 

Le système est disponible partout au moyen de navigateurs Web et sur tous types 

d’appareils. 

 

- ENVI 

ENVI (ENvironment for Visualizing Images), est un système de traitement d’images 

issu de la télédétection développé par le langage de programmation IDL (Interactive 

Data Language) et créé par la société « ITTVIS ». C’est un logiciel permettant de 

visualiser, extraire, analyser et traiter une large gamme de formats de données 

géospatiales. Il comprend plusieurs outils et fonctionnalités qui permettent de réaliser 

un grand nombre de méthodes de traitement d’images de corrections géométriques et 

radiométriques, d’analyse topographique et de classification cartographique. 

 

1.1.2. Prétraitement 

Le prétraitement d’images désigne l’ensemble des processus visant à améliorer les 

caractéristiques d’une image et à permettre une analyse thématique sur des données brutes. Les 

opérations de prétraitement des scènes recueillies consistent en une élimination des perturbations 

atmosphériques et géométriques permettant d’obtenir des images précises. C’est pourquoi, une 

stratégie comprenant plusieurs méthodes utilisées selon le besoin, doit être mise en place, on 

https://fr.wikipedia.org/wiki/Environmental_Systems_Research_Institute
https://fr.wikipedia.org/wiki/Environmental_Systems_Research_Institute
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compte parmi ces méthodes, la calibration des images avec les logiciels adéquats, la correction 

atmosphérique et géométrique, l’étalonnage radiométrique et l’orthorectification. 

Il est conseillé d’entreprendre la stratégie de prétraitement afin de modifier l'aspect d'une 

image facilitant ainsi l’extraction des informations requises et la suppression du bruit en vue 

d’obtenir un meilleur résultat pour un traitement ultérieur. 

Le type et le nombre de techniques de prétraitement est lié au système de télédétection. 

Les différents types de prétraitement sont : 

 

a. Etalonnage radiométrique  

Les images satellites peuvent contenir des « bruits radiométriques », causés par des 

défaillances des capteurs, par des problèmes de transmission des données ou d’interprétation 

(codage/décodage). 

La correction radiométrique repose sur une approche physique et consiste à transformer 

le signal reçu par le capteur en une valeur ayant un sens physique qui est la radiance. Elle est 

généralement réalisée directement lors de la réception de l’image. Cette correction est destinée à 

l’amélioration de la lisibilité des images captées et à l’extraction de caractéristiques optiques (par 

exemple la réflectance) dans le but de développer l’utilisation de ces données. 

 

b. Détection des nuages  

Les nuages représentent parfois un problème majeur dans les images, car ceux-ci, sont 

susceptibles d’assombrir la surface sous-jacente du sol et provoquer un effet sur les processus de 

mise en mosaïque des images, c’est pour cela qu’il est nécessaire d’identifier et de masquer les 

nuages.  

Cette technique de prétraitement consiste à masquer les pixels nuageux de l’image afin 

de garantir que les paramètres géophysiques soutirés sont bien caractéristiques de la surface 

terrestre.  

 

c. Correction atmosphérique  

Ce prétraitement vise à soustraire le signal causé par les effets atmosphériques tels que 

l’absorption et la diffusion dues aux gaz, à partir du signal mesuré au niveau du capteur. Il prend 

en compte la contribution du rayonnement atmosphérique qui arrive au capteur. 

 

d. Création d’un fichier multibandes (empilement des couches) 

L’ensemble de données doit être incorporé dans un seul fichier multibandes. Comme les 

trois sous-systèmes contiennent des données à différentes résolutions spatiales, tous les sous-

systèmes d’entrées doivent être rééchantillonés et projetés en un utilisateur de sortie sélectionné 

et une taille de pixels communs. Le fichier de sortie aura alors une étendue géographique 

englobant tous les fichiers d'entrées, et ce, dans le cas de l’utilisation de la totalité des données. 

Cependant, il est également possible de créer un fichier multibandes contenant des données ayant 

la même résolution spectrale, et ce, selon le besoin (J.R. Gozzard, 2006). 

 

e. Mise en mosaïque des images 

Il est possible que dans certains cas, la région d’étude soit couverte par plusieurs granules 

(scènes) en raison de l’empreinte relativement faible des granules. 
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Il sera donc nécessaire de combiner plusieurs images adjacentes pour former une seule image 

plus grande. Dans des circonstances normales, il y a trois restrictions à la création d'images en 

mosaïque. Premièrement, chaque image doit avoir le même point de référence, par exemple, 

GDA94. Deuxièmement, chaque image doit être de la même projection cartographique, par 

exemple, MGA, UTM, Albers Equal Area. Troisièmement, chaque image doit avoir une rotation 

commune. C'est-à-dire que chaque image doit être tournée de la même quantité à partir du nord 

(J.R. Gozzard, 2006). 

 

f. Obtention de sous-scènes Landsat- 8-OLI 
 

Cette étape permet de délimiter la zone d’étude exacte sur l’image satellitaire collectée, 

et ce, par rapport à la carte géologique de référence afin de faciliter la superposition et la 

comparaison des résultats.  

 

1.1.3. Méthodes d’extraction de l’information à partir de l’imagerie  

Le traitement d’images est défini comme étant l’ensemble des techniques et méthodes 

dont le but est d’obtenir des informations jugées pertinentes. Cette phase comporte plusieurs 

techniques essentielles, employées pour générer des produits utilisés par la suite à des fins 

géologiques. 

Dans cette partie, nous introduisons un aperçu définissant les notions de base sur les 

techniques de traitement les plus fréquentes utilisées dans le domaine de la cartographie et de la 

prospection minière. 

 

a. Le démixage spectral 

Le démixage spectral est la procédure par laquelle le spectre mesuré d'un pixel mixte est 

décomposé en une collection de spectres constitutifs, ou éléments terminaux, et en un ensemble 

de fractions correspondantes, ou abondances, qui indiquent la proportion de chaque élément 

terminal présent dans le pixel. Les éléments terminaux correspondent normalement à des objets 

macroscopiques familiers de la scène, tels que l'eau, le sol, le métal, la végétation, etc. De façon 

générale, le non mélange est un cas particulier du problème inverse généralisé qui, estime les 

paramètres décrivant un objet à l'aide d'une ou de plusieurs observations d'un signal, qui a interagi 

avec l'objet avant d'arriver au capteur (A. Tarantola et al., 1982). 

Le démixage spectral a fait l’objet d’une autre définition par (Nirmal Keshava and John F. 

Mustard, 2002), qui stipulent qu’elle est basée sur le principe de la décomposition d'un pixel mixte 

en une collection de spectres distincts, ou membres finaux, et un ensemble d'abondances 

fractionnaires qui indiquent la proportion de chaque membre final.  

 

b.  Les bandes ratios 

Le rationnement des bandes représente une transformation d’image multispectrale basée 

sur la réflectance entre les bandes, telle que cette transformation s’effectue par un calcul de 

rapports selon la largeur totale du spectre électromagnétique. Une large plage de rapports peut 

être obtenue selon plusieurs critères, dont la zone d’étude, la nature des minéraux et le type de 

lithologies. Le but principal de cette technique est donc, d’améliorer les différences spectrales 

entre les bandes, réduire les effets d'ombre causés par la topographie (A. Ciampalini, 2013). 
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c. L’amélioration des images multi-spectrales en couleurs composites  

C’est une transformation de l’image combinant le traitement des données de diverses 

bandes spectrales permettant de montrer plus facilement certains éléments de la scène traitée. 

Le principe des compositions colorées repose sur l’affectation d’une bande spectrale d’un capteur 

satellite pour les couleurs (rouge, vert et bleu). Selon l’affectation, on obtient deux types de 

composition, la composition en « vraies couleurs » et la composition en « fausses couleurs ». 

 

- L’amélioration en vraies couleurs  

Cette amélioration repose sur l’affectation des bandes rouge, verte et bleu aux canaux rouge, vert 

et bleu respectivement. 

 

- L’amélioration en fausses couleurs composites (FCC) 

Dans le cas de la composition en fausses couleurs, l’image est obtenue lorsque ses bandes 

spectrales ne correspondent pas aux trois couleurs primaires. D’où, la couleur réelle de l’objet et 

sa couleur affichée dans l’image sont différentes. 

De ce fait, pour chaque application donnée, est attribuée une méthode de production d’images en 

fausses couleurs. 

Ainsi, la signature spectrale des surfaces et l’œil de l’observateur permettent de discriminer les 

différents types de milieux. 

 

d. La classification  

- La classification non-supervisée  

Le but de cette classification est de détecter des groupements au sein de la population 

d’apprentissage sans aucune connaissance à priori sur les données à classer. Par conséquent, elle 

nécessite une quantité minimale d’entrée initiale de la part de l’analyste (E, Tonye, 2000). Des 

programmes appelés algorithmes de classification sont utilisés pour déterminer les groupes 

statistiques naturels ou les structures des données :  

 

 L’algorithme des nuées dynamiques ISODATA 

L’ISODATA Iterative Self-Organizing Data Analysis Technique) (Jahne, 1991), est un 

algorithme permettant de calculer les moyennes des classes uniformément reparties dans 

l’espace des niveaux de gris et regroupe les pixels restants de manière itérative en 

utilisant la technique de la distance minimale. A chaque itération, il faut recalculer les 

moyennes et classifier à nouveau les pixels en tenant compte des nouvelles moyennes. 

La fusion, l’éclatement ou l’annulation itérative des classes sont effectués selon des 

paramètres d’entrée fixant certains seuils. Tous les pixels sont associés à la classe qui 

leur est la plus proche à moins qu’un écart type ou une distance seuil soit spécifiée. Ce 

processus continue jusqu’à ce que le nombre de pixels dans chaque classe ne change 

plus d’une valeur supérieure au seuil fixe pour le nombre de pixels par classe, ou jusqu’à 

ce que le nombre maximal d’itérations soit atteint (Akono et al., 2005). 
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 Le regroupement par moyennes K-means (H. Derdjini, 2017) 

K-Means est un algorithme de clustering (en grappes) qui divise les observations en k-

clusters. Puisque nous pouvons dicter le nombre de clusters, il peut être facilement 

utilisé dans la classification où nous divisons les données en clusters qui peuvent être 

égales ou supérieures au nombre de classes. 

Le principe repose sur la supposition de l’existence de K-classes distinctes et différentes, 

puis l’attribution de K- centres de classes μ1,..., μK, ces derniers peuvent être choisis ou 

aléatoires.  

Par la suite, vient la réalisation des deux étapes suivantes : 
 

- Pour chaque élément ne représentant pas un centre de classe, trouver quel est le centre de 

classe le plus proche, ce qui définit ainsi K-classes représentant l’ensemble des points les 

plus proches du centre. 

- Définir pour chaque nouvelle classe un centre représentant le barycentre des points. La 

condition d’arrêt de l’algorithme est fixée par l’utilisateur et peut être soit le nombre maximal 

d’itérations, la convergence (entre deux itérations les classes formées restent les mêmes de 

l’algorithme ou la presque convergence (l’inertie intra-classe ne s’améliore quasiment plus 

entre deux itérations). 

 

 L’analyse en composantes principales ACP 

C’est une technique statistique multivariée représentant une transformation 

mathématique basée sur le choix de combinaisons linéaires non corrélées de bandes et 

l’analyse de covariance de l’image. Les résultats de l’ACP montrent que le pourcentage 

de variance de données diminue de sa valeur maximale atteinte dans la première bande, 

jusqu’à sa valeur minimale dans la dernière bande (A. Ciampalini, 2013). 

Il existe trois types d’analyses en composantes principales, qui sont les suivantes (A. 

Ciampalini, 2013) :  

 

- ACP non normalisée (matrice de covariance) 

C’est une transformation qui utilise des matrices de covariance adaptées selon les sous-ensembles 

traités. En général, les CP contiennent des informations spectrales utiles décrivant des 

caractéristiques spécifiques selon les bandes. 

 

- ACP standardisée (matrice de corrélation) 

C’est une technique de transformation basée sur l’utilisation de la matrice de corrélation 

permettant de donner une image. 

 

- ACP sélective 

C’est une transformation qui permet d’augmenter la fiabilité d’une CP afin de cartographier et 

délimiter les anomalies, éclairer la signature spectrale végétative. 

En général, l’objectif de l’ACP est de séparer les composantes de bruit, réduire la dimensionnalité 

des ensembles de données, réaliser une cartographie géologique et une cartographie d’altération. 
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1. La classification supervisée 

La classification supervisée est une technique qui utilise une base de connaissance décrivant les 

différentes classes d’un échantillon donné. Dans ce type de classification basé sur le pixel, il est 

nécessaire d’avoir une connaissance du site d’étude. 
 

L’objectif de cette technique est de concevoir un classificateur pouvant attribuer toute 

observation inconnue à une classe parmi celles déjà définies. Le classificateur nécessite une phase 

d’apprentissage avant d’être utilisable, lors de cette phase, le classificateur divise l’espace 

prototype dont les paramètres des différentes classes ont été préalablement déterminés par un 

superviseur (E. Tonye, 2000).  

 

 

 

 

 

 

 

 

 

 

Figure 3.1 : Concept de la classification supervisée (N. Boudali, 2012) 

 

La démarche scientifique reste la même pour chacune des méthodes de classification, à 

l’exception du choix des algorithmes de classification. 
 

Les classifications supervisées sont des méthodes permettant d’obtenir un résultat rapide et 

généralement assez efficace, elles sont particulièrement utilisées dans le cadre d’images dont la 

résolution spatiale n’est pas très élevée. 
 

 Le maximum de vraisemblance  

La méthode de maximum de vraisemblance consiste à définir des échantillons distincts 

estimés représentatifs des classes auxquelles on veut les affecter, prédéfinies au 

préalable. Après la définition des classes et de leurs situations sur l’image, elles seront 

par la suite définies dans le logiciel de traitement comme étant des régions d’intérêts 

pour déterminer les classes spectrales les représentant pour appliquer par la suite un 

algorithme de classification, qui va affecter chaque pixel de l’image à une des classes. 
 

 Spectral Angle Mapper  

La méthode du SAM est une approche de classification basée sur la similarité angulaire 

entre les spectres de l'image et des spectres de référence. Extraits de l'image elle-même, 

ces derniers sont des spectres extrêmes, dits pôles spectraux, par rapport auxquels la 

méthode du SAM mesure l'angle spectral des pixels (Kruse et al, 1993). Ces derniers et les 

pôles spectraux sont considérés comme des vecteurs ayant des valeurs dans un espace 

de dimension égale au nombre de bandes de l'image utilisée. Leur représentation dans 
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un espace multidimensionnel permet de mesurer l'écart angulaire qui les sépare (Figure 

3.2). 
 

L'attribution d'un pixel à un thème donné se base sur la mesure de l'angle a, c'est-à-dire 

l'angle entre le vecteur du spectre de référence et celui de chaque vecteur dans l'image. 

Plus l'angle est petit, plus la similarité entre le spectre du pixel évalué et la référence est 

grande. Ainsi, le pixel sera affecté à la classe du pôle spectral avec lequel il a le plus 

petit écart angulaire. Cette mesure est peu sensible aux variations de l’éclairement dont 

l'augmentation ou la diminution n'affecte pas la direction du vecteur, mais plutôt son 

amplitude (Clark et al, 1995). Un mauvais choix de l'angle a peut engendrer un nombre 

minimal de classes, soit des confusions non souhaitables et un nombre maximal de 

pixels non classés (Crosta et al, 1998). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3.2 : Concept de la méthode du SAM où a  est l'angle spectral entre le spectre de 

référence et le spectre évalué dans un espace à deux dimensions (D'après Kruse et al, 1993) 

 

 

La méthode SAM qui est basée sur le calcul de l’angle spectral est utilisée pour cartographier les 

occurrences spectrales similaires permettant d’identifier les diverses classes de l’image satellite 

de la région d’étude. L'angle spectral est calculé entre le vecteur de test construit pour chaque 

pixel et le vecteur de référence construit pour chaque classe de référence.  

Le codage couleur est ensuite appliqué pour distinguer entre les différentes classes qui ont été 

reconnues par l'algorithme SAM. 

 

2. La post-classification  

Les images classifiées manifestent souvent une apparence bruyante en raison de la variabilité 

spectrale inhérente qu'un classificateur rencontre lorsqu'il est appliqué pixel par pixel. Dans de 

telles situations, il est souvent souhaitable de lisser les images classifiées pour ne montrer que la 

classification dominante présumée correcte. Ainsi, des processus de post-classification ont été 
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appliqués sur une image classifiée afin d'éliminer les pixels isolés et de générer une image 

apparemment moins bruyante. Des recherches antérieures ont indiqué que le traitement post-

classification est une étape importante dans l'amélioration de la qualité des classifications 

(Harris et Ventura 1995 Harris, P. M. et Ventura, S. J. 1995). Les différents outils de la post-classification 

sont décrits dans ce qui suit : 
 

 Agrégation de classification (Classification agregation)  

L’agrégation de classification est un outil de nettoyage utile lorsque le résultat de la 

classification inclut de nombreuses petites régions, son principe repose sur la réalisation 

d’un regroupement des régions de classe adjacentes plus petites à une région plus grande 

(H. Derdjini, 2017). 
 

 Regroupement des classes (Clumping classes)  

C’est un outil qui est utilisé pour regrouper des zones classifiées similaires adjacentes à 

l'aide d'opérateurs morphologiques. Du fait que les images classées manquent de 

cohérence spatiale (chatoiement ou trous dans les zones classées), le Clumping classes 

regroupe les classes et applique un lissage en effectuant d'abord une opération de 

dilatation puis une opération d'érosion sur l'image classifiée (H. Derdjini, 2017). 
 

 Analyse de la minorité ou majorité (Minority/Majority Analysis)  

C’est une analyse qui se base sur la modification des pixels parasites au sein d’une classe 

unique de grande taille, où par un choix d’une taille de noyau qui fait référence à la 

classe , le pixel central dans le noyau sera remplacé par la valeur de classe qui a la 

majorité des pixels dans le noyau, sinon si on utilise une analyse par minorité le pixel 

central dans le noyau sera remplacé par la valeur de classe qui a la minorité des pixels 

dans le noyau (H. Derdjini, 2017). 

 

e. La fraction minimale de bruit (Minimum Noise Fraction MNF) 

C’est une méthode similaire à l’ACP et considérée comme étant une transformation 

préparatoire condensant la majorité des composants essentiels en bandes spectrales permettant 

ainsi une classification  selon un intérêt croissant. La transformation de la fraction de bruit 

minimale (MNF), est un algorithme basé sur la réalisation de deux étapes, l’une après l’autre, où 

la première consiste en l’évaluation du bruit dans les images représentées par une matrice de 

corrélation et la deuxième permet d’obtenir un groupe de composantes qui contient des 

informations sur la variance dans les bandes, et ce, en prenant en considération les corrélations. 

Cette méthode facilite la détermination de la dimensionnalité des images, l’élimination, 

l’isolement et la réduction du bruit dans les données (F. Al-Nahmia et al, 2017) (E. Mansouri et al, 2013). 

 

1.1.4. Interprétation des résultats 

L’analyse des données obtenues qui suit la phase de traitement représente une étape 

fondamentale consistant à élaborer des réponses aux questions d’intérêt, et ce, dans le but de 

réaliser un examen, une évaluation et une interprétation des données afin de résumer et 

communiquer des résultats qui vérifie si l’hypothèse de la recherche est vraie ou fausse. 

 

 

https://www.researchgate.net/profile/Edris_Mansouri
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1.1.5. Validation et comparaison 

Après l’obtention des résultats de traitement d’images, on entame la phase de validation 

basée sur la comparaison entre les produits de traitement et les données de terrain tels que les 

cartes géologiques de la région d’étude et les résultats d’analyse sur les échantillons prélevés. Le 

but de cette comparaison est de prouver l’efficacité du processus de traitement et l’exactitude des 

données recueillies préalablement. 

 

1.2.  Choix des méthodes 

En se basant sur l’évaluation et la synthèse des diverses littératures traitant l’utilisation 

de la télédétection dans la prospection minière et la cartographie géologique, l’adaptation de 

l’approche méthodologique citée auparavant sur notre cas d’étude nous a permis de sélectionner 

un nombre de méthodes et outils nous facilitant d’extraire des informations utiles selon un 

processus décrit dans l’organigramme suivant : 
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Figure 3.3 : Organigramme du processus de traitement (Elaboré par nous-mêmes) 
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1.2.1. Acquisition des images et logiciels de traitement  

L’ensemble des méthodes de prétraitement et traitement ont été, dans notre cas d’étude 

sur des images satellitaires collectées par le satellite Landsat-8-OLI, obtenues à partir du site de 

la NASA – USGS : https://earthexplorer.usgs.gov/.  

 

La réalisation du processus d’extraction nécessite la disponibilité du matériels adéquats 

selon le besoin, donc pour réaliser ce processus, on utilisera les logiciels ENVI en raison de son 

accessibilité au public.  

L’annexe 1 montre l’interface du logiciel ENVI. 

 

 

 

 

 

 

 

Tableau 3.5 : Caractéristiques des images Landsat-8-OLI (usgs.gov, 2019) 

Lieu Coordonnées Dates et heures locales des 

mesures 

Gara-Djebilet (Tindouf) 26° 52' 53.8" N ; 

 7° 10' 0.6" W. 

29-04-2019 ; 10 : 58 : 34 

Ouenza (Tébessa) 35° 56' 41.8" N ; 

8° 05' 35.8" E. 

07–05–2019 ; 10 : 06 : 49 

 

 

 

 

 

Figure 3.4a : Image Landsat-8 

OLI en mode RVB de la région de 

Gara-Djebilet (usgs.gov, 2019) 

Figure 3.4b : Image Landsat 8 

OLI en mode RVB de la région de 

Djebel Ouenza (usgs.gov, 2019) 

https://earthexplorer.usgs.gov/
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1.2.2. Prétraitement 

Dans le cas du prétraitement des images Landsat-8-OLI, l’étalonnage radiométrique n’a 

pas été appliqué car les images acquises sont déjà en réflectance du fait que le capteur OLI établit 

des corrections au préalable en raison de ses deux  dispositifs d’étalonnage embarqués, ce qui est 

de même pour la correction atmosphérique en raison de la non disponibilité des données 

atmosphériques pour la définition des paramètres pris en compte dans l’ENVI, mais aussi 

l’application d’un masquage de nuage n’est pas obligatoire du fait de la netteté des images 

satellitaires Landsat-8-OLI, de plus le prétraitement par mosaïquage d’images n’est pas 

nécessaire parce que chaque région d’étude est situé dans un seul granule pour chaque cas 

quelques soit la date d’acquisition de l’image. Cependant seules les étapes de création d’un 

fichier multibandes ou empilement de couches et l’obtention des sous scènes sont nécessaires. 

 

 LAYER STACKING  

 Djebel Ouenza 

Dans le cas de la région de Djebel Ouenza, nous avons utilisé huit bandes, soient les 

bandes Aérosol, Bleu, Vert, Rouge, SWIR1 (IRCL1), SWIR 2 (IRCL2), NIR (PIR) et 

Cirrus. 

 Gara Djebilet  

Pour la région de Gara Djebilet, nous avons utilisé sept bandes, soient les bandes 

aérosol, bleu, vert, rouge, SWIR1 (IRCL1), SWIR2 (IRCL2), et NIR (PIR). 

Voir l’annexe 2 pour les étapes de création d’un fichier multibandes. 

 SPATIAL CROP  

Les étapes de l’obtention des sous-scènes et les dimensions utilisées pour chacune des deux 

régions sont citées dans l’annexe 3.  

 

1.2.3. Méthodes d’extraction de l’information à partir de l’imagerie  

Pour effectuer le traitement des images des deux régions d’Algérie Ouenza et Gara-

Djebilet, une sélection de méthodes a été mise en place en relation avec la zone d’étude, et ces 

méthodes sont :  

a. L’amélioration des images multi-spectrales (Couleurs réelles et Fausses couleurs)  
 

La technique d’amélioration en couleurs naturelles est généralement utilisée comme 

première image pour l’analyse des données satellitaires et comme image complète pour les non 

experts dans les données satellitaires. Elle est considérée comme l’une des plus simples 

combinaisons où en accorde de manière élémentaire les bandes 4, 3 et 2 aux canaux rouge, vert 

et bleu respectivement. 

Toutes les autres combinaisons sont en fausses couleurs, donc suite à l’application d’un certain 

nombre d’essais, l’attribution des bandes 7, 3 et 2 aux canaux rouge, vert et bleu respectivement 

a donné de meilleurs résultats dans les deux régions. 
 

L’annexe 4 décrit le processus de réalisation des deux types d’amélioration. 
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b. La classification  
 

3. La classification non supervisée  

 ISODATA  

L’algorithme IsoData sélectionne le nombre de classes à définir dans les paramètres 

selon la carte de référence. On introduit ensuite le nombre maximum d'itérations et le 

seuil de changement. Ce dernier est utilisé pour terminer le processus itératif si le 

nombre de pixels dans chaque classe varie de moins que le seuil. On introduit le nombre 

minimum de pixels requis pour former une classe. Enfin, on introduit la distance 

minimale entre les moyennes de chaque classe. 

Les paramètres utilisés selon les différents essais pour chaque région sont : 
 

Djebel Ouenza  

 

Tableau 3.6a : Paramètres des essais de la méthode ISODATA pour la région de Djebel Ouenza 

(Elaboré par nous-mêmes)  

 Essai 1 Essai 2 Essai 3 Essai 4 

Intervalles du 

nombre de 

classes 

 

8 – 11 

 

4 - 6 

 

6 – 10 

 

6 – 10 

Nombre 

maximal 

d’itérations 

 

1 

 

2 

 

3 

 

3 

Seuil de 

changement (%) 

5 5 5 5 

Nombre 

minimal de 

pixels dans une 

classe 

 

1 

 

7 

 

14 

 

20 
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Gara-Djebilet 

 

Tableau 3.6b : Paramètres des essais de la méthode ISODATA pour la région de Gara-Djebilet 

(Elaboré par nous-mêmes) 

 Essai 1 Essai 2 Essai 3 Essai 4 

Intervalles du 

nombre de 

classes 

 

6 – 10 

 

6 – 12 

 

6 – 10 

 

6 – 12 

Nombre 

maximum 

d’itérations 

 

2 

 

4 

 

4 

 

2 

Seuil de 

changement 

(%) 

5 5 5 5 

Nombre 

minimal de 

pixels dans une 

classe 

 

1 

 

5 

 

7 

 

 

10 

 

Parmi les différents essais effectués comme cités dans les tableaux précédents, nous avons choisi 

les paramètres de l’essai 3 pour les deux régions en raison des bons résultats obtenus. 

 

 K-means 

Pour la classification k-means, nous avons limité notre choix sur un nombre de classes 

adéquats et ce, en prenant en considération la carte de référence afin de rendre la 

classification plus claire, nous avons aussi effectuer un changement de valeurs au niveau 

des itérations pour avoir des résultats plus fiables et pour ce qui est du seuil de 

changement  les valeurs attribuées était aléatoires au voisinage de la valeur par défaut.  
 

Djebel Ouenza  

 

Tableau 3.7a : Paramètres des essais de la méthode K-means pour la région de Djebel 

Ouenza (Elaboré par nous-mêmes) 

  Essai 1 Essai 2 Essai 3 Essai 4 

Nombre de 

classes 

  

8 

 

10 

 

6 

 

8 

Seuil de 

changement 

(%) 

  

4 

 

3 

 

6 

 

5 

Nombre 

maximal 

d’itérations 

  

8 

 

10 

 

6 

 

10 
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Gara-Djebilet 

 

Tableau 3.7b : Paramètres des essais de la méthode K-means pour la région de Gara Djebilet 

(Elaboré par nous-mêmes) 

 Essai 1 Essai 2 Essai 3 Essai 4 

Nombre de 

classes 

 

10 

 

5 

 

12 

 

10 

Seuil de 

changement 

(%) 

5 7 5 3 

Nombre 

maximal 

d’itérations 

 

4 

 

1 

 

5 

 

7 

 

Pour le choix des paramètres des différents essais réalisés, on opte pour l’essai 1, concernant la 

région de l’Ouenza et l’essai 3 pour Gara-Djebilet. 

En principe, l'analyse non-supervisée est un processus itératif où l'utilisateur définit des valeurs 

arbitraires qui, seront modifiées selon les résultats. Cette analyse nous permettra par la suite 

d’affirmer nos choix par rapport aux régions d’intérêts. 

L’annexe 5 décrit le processus de classification non-supervisée. 

 

4. La classification supervisée  

 Maximum Likelihood  

Le principe de la classification dirigé par la procédure de maximum de vraisemblance 

consiste à comparer la signature spectrale de chaque pixel dans les bandes choisies (dans 

notre cas : bleu, vert, rouge et proche infrarouge et courte longueur d’onde infrarouge) 

avec celle des Régions d’intérêts (Regions Of Interest). 

Il s’agit de sélectionner un minimum de pixels spectralement représentatif dans chaque 

ROI. Cet échantillon, ou ‘ROI’ est défini à l’écran par la numérisation des pixels ou 

polygones pour chaque classe spectrale. Sur la base des polygones ainsi définis, 

l’extraction automatique des valeurs de pixels contenues à l’intérieur des polygones et 

le calcul de leur moyenne et écart-type produira la signature spectrale de chaque classe 

à partir des bandes choisies de l’image Landsat. Puis affecter chaque pixel à la classe 

dont laquelle la signature spectrale est proche. 

Voici ci-dessous les tableaux représentatifs des ROI avec leurs couleurs attribuées : 
 

Djebel Ouenza  

Selon plusieurs essais pour la région de Djebel Ouenza, il était nécessaire d’établir un 

regroupement de classes ayant des formations similaires, tel qu’on a défini seulement 5 classes 

en regroupant  le cénomanien, le Santorien, le Turonien  et le Coniacien  dans une seule classe 

appelée Crétacé Supérieur et  l’Aptien calcaire et Aptien marneux en une classe appelée Aptien, 

et ce pour avoir un résultat explicite. 
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Tableau 3.8a : Classes choisies et couleurs attribuées pour la région de Djebel Ouenza (Elaboré 

par nous-mêmes) 

Classe Couleur 

Aptien calcaire  Red  

Aptien marneux  Yellow 2 

Albien  Cyan 2 

Vraconien  Cyan 3 

Crétacé supérieur  Aquamarine  

Trias  Magenta 1 
 

 

Gara-Djebilet  

 

Tableau 3.8b : Classes choisies et couleurs attribuées pour la région de Gara-Djebilet 

(Elaboré par nous-mêmes) 

Classes Couleur 

Post Paléozoïque  Yellow 

Frasnien Green 

Eifelien Marron 3 

Emsien  Cyan 3 

Praguien Marron 2 

Fer Red 

Lochkovien Blue  

Givétien  Cyan  

Silurien  Blue 3 

Ordovicien sup  Magenta  

Précambrien  Red 3 

 

 Spectral Angle Mapper (SAM) 

C’est une autre méthode assez fréquemment utilisée dans la classification supervisée 

qui partant d’une librairie spectrale préexistante généralement prise sur le terrain à l’aide 

d’un spectromètre ou en laboratoire avec des échantillons de terrain de référence tel que 

l’on attribue chaque pixel de l’image à une classe en le comparant avec les échantillons 

de référence de la librairie. Dans notre cas, nous ne disposons pas d’une librairie 

spectrale pour les deux régions Ouenza et Gara- Djebilet, il faudrait donc la construire 

en se basant sur l’attribution d’un spectre de référence pour classifier les pixels. 

 

 

 

 

 

 

 

 
 



Chapitre 3 : Méthodes, Matériels et Outils                                                                                . 
 

83 
 

Djebel Ouenza  

 

Tableau 3.9a : Librairie spectrale pour la région de Djebel Ouenza (Elaboré par nous-mêmes) 

Nom du spectre Couleur 

Aptien  Red  

Albien  Green  

Vraconien  Blue 

Cénomanien  Yellow 

Trias  Cyan  

 

Gara-Djebilet 

 

Tableau 3.9b : Librairie spectrale établie pour la région de Gara-Djebilet (Elaboré par nous-

mêmes) 

Nom du spectre Couleur 

Post Paléozoïque  Yellow  

Frasnien  Blue  

Eifelien  Sienna 1 

Emsien  Aquamarine  

Praguien  Magenta  

Fer  Red  

Lochkovien Maroon  

Givétien  Purple  

Silurien  Sea Green  

Ordovicien supérieur  Magenta  

Précambrien  Red 3 

 

Voir l’annexe 6 pour le processus de classification supervisée. 

 

5. La post-classification  
 

Afin de mieux améliorer les résultats obtenus à partir des méthodes de la classification qu’elle 

soit supervisée ou non-supervisée, une post-classification est nécessaire, parmi les méthodes 

citées auparavant, deux processus de la post-classification ont été appliqués aux images qui sont 

classées par ISODATA, K-means, Maximum Likelihood et SAM,  

- Le premier étant l’analyse en minorité ou majorité où une modification des pixels parasites 

est établie,  
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- par la suite le deuxième processus qui est celui du regroupement par classes est réalisé où le 

clump est lancé pour ajouter une cohérence spatiale aux classes existantes en combinant des 

zones classées similaires adjacentes. 

La plupart des classifications d'images sont basées sur des réponses spectrales détectées. En 

raison de la complexité des environnements biophysiques, la confusion spectrale est courante 

parmi les classes de couverture terrestre. Ainsi, les données auxiliaires sont souvent utilisées pour 

modifier l'image de classification sur la base de règles d'expertise établie. 

L’annexe 7 décrit le processus de post-classification dans ENVI Classic. 
 

c. Le démixage spectral linéaire  
 

Le démixage linéaire repose sur le même principe que la méthode de classification SAM, 

pour définir les librairies spectacles de référence pour arranger les pixels, cependant la seule 

différence réside dans le résultat obtenu où les classes deviennent des bandes spectrales, de plus 

dans l’affichage, on peut repérer une classe précise par affichage en niveau de gris ou bien on 

peut attribuer les classes qu’on juge importantes dans notre étude au canaux rouge, vert  et bleu  

en  mode RGB. 

 

Djebel Ouenza  

Pour la région de Djebel Ouenza, la librairie spectrale utilisée est identique à celle de la méthode 

SAM, où nous avons utilisé 5 classes ayant permis la distinction entre l’aptien calcaire et l’aptien 

marneux. 
 

 

Gara-Djebilet  

Concernant la région de Gara- Djebilet, l’utilisation de la même librairie spectrale que celle de 

la méthode Spectrale Angle Mapper a donné un meilleur résultat dans les différents essais.  

L’annexe 8 décrit la méthode de démixage spectral linéaire réalisé sous ENVI pour Djebel 

Ouenza et Gara Djebilet. 
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d. Les bandes ratios  

Les ratios de bandes généralement utilisés avec Landsat- 8-OLI sont : 

 

Tableau 3.10a : Ratios communément utilisés pour Landsat-8 

Features Band or ratio Reference 

Ferric iron, Fe3+  

4/1 

Drury, 1993 ; Abrams and 

Hook, 1995 ; Lillesand and 

Kieffer, 2004 ; Kalinowski 

and Oliver, 2004 

Ferrous iron, Fe2+  

6/5 

Drury, 1993 ; Abrams and 

Hook, 1995 ; Lillesand and 

Kieffer, 2004 ; Kalinowski 

and Oliver, 2004 

Iron oxide 3/1 Gad and Kusky, 2006 

Clay minerals  

6/7 

Drury, 1993 ; Abrams and 

Hook, 1995 ; Lillesand and 

Kieffer, 2004 ; Kalinowski 

and Oliver, 2004 

Magnetic contents 5/1 Sabins, 1999 

Hydroxyl bearing rocks or 

carbonates 

5/7 Sultan et al, 1987 

Iron ore and mafic 

saprolite 

(4+6)/5 Rockwell 2013 

Clay minerals 7/4 Laake, 2011 

Metavolcanic (5/4)*(3/4) Rajendran et al, 2007 

Ferrous minerals (5/4) Carranza and Hale, 2002 

Biomass - vegetation (5/4) Drury, 1993 ; Abrams and 

Hook, 1995 ; Lillesand and 

Kieffer, 2004 ; Kalinowski 

and Oliver, 2004 

 

 

Djebel Ouenza  

 

Tableau 3.10b : Les combinaisons de bandes utilisées pour la cartographie du minerai de fer 

pour la région de l’Ouenza (Elaboré par nous-mêmes) 

 

MODE COMBINAISON 

1 
COMBINAISON 

2 
COMBINAISON 

3 
COMBINAISON 

4 
COMBINAISON 

5 

R NIR 6/5 (4+6)/5 (4+6)/5 5/7 

V (4+6)/5 (4+6)/5 SWIR 1 SWIR1 SWIR1 

B 4/3 NIR Vert 6/5 Vert 
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Gara-Djebilet  

 

Tableau 3.10c : Les combinaisons de bandes utilisées pour la cartographie du minerai de fer 

pour la région de Gara-Djebilet (Elaboré par nous-mêmes) 

 

MODE COMBINAIS

ON 

COMBINAIS

ON 2 

COMBINAIS

ON 3 

COMBINAIS

ON 4 

COMBINAIS

ON 5 

COMBINAIS

ON 6 

R 4/1 4/1 (4+6)/5 6/7 (4+6)/5 4/1 

V SWIR 1 (4+6)/5 SWIR 1 3/1 NIR 3/1 

B Vert 3/1 Vert (4+6)/5 SWIR 1 6/7 
 

L’annexe 9 décrit le processus d’application de la méthode des bandes ratios. 

 

e. Minimum Noise Fraction (MNF) 
 

Cette méthode facilite la détermination de la dimensionnalité des images, l’élimination, 

l’isolement et la réduction du bruit dans les données. 

L’annexe 10 décrit le processus permettant d’effectuer l’analyse en fraction de bruit minimale 

MNF. 

 

1.2.4. Interprétation des résultats  

L’interprétation des résultats du traitement sera faite selon les cartes géologiques de 

référence des deux régions. 

Figure 3.5a : Carte géologique de référence de la région de Djebel Ouenza (D’après 

Dubourdieu, 1956, modifié par Vila, 1994) 
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Figure 3.5b : Carte géologique de référence de la région de Gara-Djebilet (Chabou, Saibi, Bersi ; 

2015) 
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Conclusion  

Compte tenu des caractéristiques des régions d’études, il a été jugé indispensable et 

préférable d’utiliser des images Landsat, et ce, premièrement en raison de leur disponibilité et 

caractère pratique, et deuxièmement, ils fournissent des images récentes et de bonne qualité et 

principalement pour leur avantage, au besoin, de cartographier les zones de fortes oxydation 

(chapeau de fer) dont les minéraux composants possèdent des patrons d’absorption dans les 

bandes Proche Infrarouge.  

De ce fait, les méthodes utilisées dans les deux cas d’études, sont jugées adéquates et 

appropriées selon les recommandations des spécialistes en géologie et en télédétection qui, 

définissent que l’efficacité de ces méthodes et liée de manière directe aux sites d’études et la 

nature des types de gisements ciblés (VMS, MVT, SEDEX et filons ferrifères), et ce, pour la 

réalisation de notre travail portant sur la détection, délimitation et la cartographie des deux 

gisements minier et minéral métalliques ferrifères, situés dans deux régions géologiques 

différentes d’Algérie, à savoir Ouenza au Nord-Est et Gara Djebilet au Sud-Ouest.
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Chapitre 4 
 

Interprétation des résultats 
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Introduction 

Comme cité dans les chapitres précédents, les applications des techniques de télédétection 

connues et rentables pour détecter et cartographier les zones contenant des gisements minéraux, 

grâce à la mise en valeur des images Landsat 8 OLI ont été utilisées pour mettre en évidence la 

présence de dépôts de fer d’où la nécessité d’une démarche d’interprétation afin de mieux décrire 

et expliquer les résultats obtenus, qui sera développé dans le chapitre suivant. 
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1. Résultats du traitement d’image de Djebel Ouenza 
 

1.1. Amélioration des images multi-spectrales en couleurs composites 

 

1.1.1.Couleurs naturelles 

  

Figure 4.1a : Amélioration en couleurs naturelle en RVB (Elaborée par nous-mêmes) 

 

La Combinaison RVB est considérée comme l’une des plus simples combinaisons car, on 

accord de manière simple avec les bandes 4, 3 et 2 aux canaux rouge, vert et bleu respectivement. 

L’image 4.1a, nous a servi de support pour l’application de cette combinaison de bandes en Mode 

RGB, et qui nous a permis d’effectuer une première interprétation sur l’image traitée, où l’on 

aperçoit la région de l’Ouenza en couleurs naturelles réelles, montrant ainsi les limites des 

anciens fronts de taille d’extraction du minerai, juxtaposés aux actuels front d’exploitation du 

minerai, semble-t-il de hautes concentrations de dépôt ferrifère, situés au sommet du Djebel 

Ouenza à un niveau hypsométrique de 1400 m (Pic de Chagoura), et les fronts de taille récents et 

actuels d’exploitation du minerai à partir d’autres étages géologiques situés à un niveau de 800 

m aux alentours du sommet (Chagoura Nord, Sud et Ouest).  

Pour avoir plus de détails, de précision et de vérification, on a essayé d’introduire d’autres 

bandes en mode RGB, mis à part les bandes 4, 3, et 2, on a introduit la notion de la composition 

en fausse couleur pour avoir plus de contraste à partir du rapport absorption / réflexion du 

rayonnement de la surface du gisement.  

 

 

 

 

 

 

 

 

 

 Mode RGB 
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1.1.2. Fausses couleurs 

Figure 4.1b : Amélioration en fausses couleurs (Elaborée par nous-mêmes) 

 

La surface d’oxydation du gisement est mise clairement en évidence par la présence du 

fer dans le minerai générant une forte absorption dans la bande 7, avec une réflectance supérieure 

dans la bande 3, et exprimant aussi une altération très visible des oxydes de fer décelée par une 

absorption élevée dans la bande 2.  

 

Donc suite à ces caractéristiques, on a utilisé une combinaison de bandes 7, 3 et 2, où 

chaque bande est introduite respectivement dans les canaux Rouge, Vert et Bleu. 

 

En s’appuyant sur la carte géologique de la région, la figure 4.1b illustre clairement 

l’affleurement de certaines formations géologiques (étages géologiques en relation avec leurs lithologies) 

en larges surfaces dont l’Aptien en couleur marron, et une forte oxydation de minéralisation 

ferrifère présente en couleur rouge appartenant à l’Aptien calcaire, cependant les autres 

formations sont visible à l’œil nu mais sans pour autant reconnaitre leurs limites lithologiques. 

Donc il est indispensable de faire appel à d’autres méthodes d’extraction de données sur la région 

étudiée afin d’obtenir plus de résultats beaucoup plus fiables pour mener à bien des études 

ultérieures et développer une analyse plus exhaustive. 
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1.2. Classification non-supervisée 

 

1.2.1. ISODATA 

Pour une première application d’une méthode d’extraction de données, on a procédé par 

la classification non-supervisée ISODATA à travers laquelle on a défini un nombre représentatif 

de classes des formations lithologiques correspondant à la carte géologique de la région utilisée 

comme support et référence. 

Figure 4.2a : Classification ISODATA (Elaborée par nous-mêmes) 

 

Selon la figure 4.2a, on distingue que les étages géologiques sont globalement 

individualisés mais se confondent entre eux dans le détail en raison du nombre élevé de pixels 

lié à la présence de différentes lithologies dans chaque étage géologique formant une classe dans 

la région de l’Ouenza 
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Figure 4.2b : Post-classification ISODATA (Elaborée par nous-mêmes) 

 

Cependant, on note que les travaux d’exploitation du gisement ferrifère de l’Ouenza sont 

à l’origine du remaniement, perturbation des surfaces lithologiques et déplacement des masses 

rocheuses relatives au minerai favorisant ainsi la présence des différentes lithologies dans chaque 

classe ou étage géologique. Pour pallier à ce problème de foisonnement lithologique, il est 

impératif d’effectuer une classification supplémentaire nommée post-classification afin de rendre 

le résultat meilleur ou de vérifier et confirmer les mêmes caractères élucidés par la figure 4.2a. 

 

Toutefois, en s’appuyant sur la carte géologique de référence, la figure 4.2b, vérifie et 

confirme les mêmes caractéristiques relatives aux lithologies des étages géologiques illustrées 

dans la figure 4.2a, excepté l’étage de l’Aptien calcaire qui est partiellement représenté par la 

zone verte formant de larges surfaces continues localisées dans le Djebel Ouenza. On repère aussi 

une large zone rouge correspondant à la retenue collinaire de l’Oued Mellègue, située à l’Ouest 

du gisement ferrifère de l’Ouenza. 
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1.2.2. K-means 

Le traitement par K-means a donné le résultat représenté par la figure 4.3a suivante : 

 

Figure 4.3a : Classification non-supervisée K-means (Elaborée par nous-mêmes) 
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Figure 4.3b : Post-classification non supervisée K-means (Elaborée par nous-mêmes) 

 

Les figures 4.3a et 4.3b, nous permettent de repérer les formations des étages géologiques 

les plus dominants de la région de Djebel Ouenza abritant le gisement ferrifère d’Ouenza, il s’agit 

de l’Aptien marneux et l’Aptien calcaire, dominées par de large surfaces bleues où se localise la 

concentration du minerai de fer conformément à la description lithostratigraphique de la région 

d’Ouenza; par contre le Trias, les étages du Crétacé moyen tels que le Barrémien, l’Aptien, le 

Clansayésien, l’Albien, le Vraconien et le Crétacé supérieur ne sont pas distincts les uns des 

autres, ce qui nous amène à dire que les méthodes de classification et Post-classification non-

supervisées K-means ne sont pas précises car la distribution des classes ne concorde pas avec la 

carte géologique de référence.  

 

Par conséquent, aucune des deux classifications non supervisées, soit IsoData et K-means 

ne permet de différencier clairement entre les limites des diverses formations 

lithostratigraphiques qui se trouvent dans le Djebel Ouenza, d’où la difficulté de localiser le 

gisement ferrifère de manière précise, c’est pourquoi on procède par la classification supervisée. 
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1.3. Classification supervisée  

 

1.3.1.Maximum Likelihood  

 

La procédure de classification a été établie en regroupant certaines classes selon leur 

affinité et similitude en termes de lithologie et en éliminant d’autres en raison de leur faible 

occurrence dans la zone d’étude. 

 

La prise en considération de la totalité des classes lithostratigraphiques conduit en général 

à une représentation exagérée de l’unité géologique concernée, qui se voit étendue de manière 

anormale par rapport aux différentes unités lithologiques 

Figure 4.4a : Classification supervisée par Maximum Likelihood (Elaborée par nous-mêmes) 

 

Dans le cas de la région de l’Ouenza, nous avons regroupé les unités ayant les mêmes 

formations géologiques comme le Cénomanien, le Turonien, le Coniacien et le Santonien pour 

former ainsi la classe du Crétacé supérieur selon l’échelle des temps géologiques, quant au 

Miocène, celui-ci n’a pas été pris en considération lors de la définition des ROI (Région 

d’intérêt). 
 

Donc, dans cette classification, le nombre de classes les plus représentatives de la région, a été 

réduit à six, ces classes permettent de localiser et distinguer les limites du minerai de fer par 

rapport aux autres formations géologiques voisines. 
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Figure 4.4b : Post-classification supervisée Maximum Likelihood (Elaborée par nous-mêmes) 

 

Il est clair que certaines formations sont plus ou moins visibles sur la figure 4.4b, tel que 

l’on peut distinguer la formation triasique en magenta, l’Aptien calcaire en rouge contenant 

potentiellement les bonnes concentrations métalliques ferrifères, l’Aptien marneux en jaune-ocre 

qui contient de très faibles concentrations ferrifères, le Crétacé supérieur représenté par le bleu-

cyan et le Vraconien en bleu gris.  

 

1.3.2.Méthode Spectral Angle Mapper  

L’application de la Spectral Angle Mapper sur une Image Landsat-8- OLI, a été réalisée 

par la création d’une librairie spectrale, en attribuant 5 spectres aux zones représentatives des 

formations géologiques 



Chapitre 4 : Interprétation des résultats                                                                                                                            . 

99 
 

 

Figure 4.5a : Classification supervisée SAM (Elaborée par nous-mêmes) 

 

Les résultats collectés à partir de cette classification nous ont permis, suite à une 

comparaison avec la carte géologique de référence de la région de l’Ouenza, de déterminer les 

limites du des concentrations ferrifères fortement oxydées, il s’agit semble-t-il des anciens fronts 

de taille d’exploitation, indiquée par les surfaces vertes localisées dans le site minier ferrifère de 

Djebel Ouenza, d’autant plus que les zones noires correspondent aux surfaces d’eaux et aux 

surfaces hydromorphes.  

Afin de mieux distinguer les formations géologiques de la région de l’Ouenza abritant le 

gisement ferrifère, on a procédé par la méthode post-classification Méthode Spectral Angle, 

représentée par la figure 4.5b suivante. 
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Figure 4.5b : Post-classification supervisée SAM (Elaborée par nous-mêmes) 

 

L’objet de l’opération d’amélioration une fois effectuée, est supposée apporter une 

meilleure lecture et compréhension de l’image permettant ainsi de distinguer entre les diverses 

unités lithologiques. Cependant, le résultat conduit à l’établissement d’une interprétation 

déduisant une confusion entre toutes les entités lithostratigraphique se trouvant dans la région 

d’étude relative au périmètre du gisement ferrifère de l’Ouenza.  

 

Selon les interprétations précédentes des deux méthodes de classification et post-

classification supervisées (Maximum Likelihood et SAM), on constate qu’il est impératif de faire 

appel à d’autres méthodes de traitements pouvant aboutir à des résultats plus fiables et 

convenables. 
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1.4. Méthode Spectral Unmixing  

 

En se basant sur le principe de la méthode de Spectral Unmixing, nous avons utilisé une 

librairie spectrale similaire à celle de la méthode SAM, qui considère l’existence de cinq classes, 

et ce, pour ne pas engendrer des anomalies et confusions entre les unités lithologiques. 

Figure 4.6 : Méthode Spectral Unmixing (Elaborée par nous-mêmes) 

 

La figure 4.6 ci-dessus, nous permet de visualiser les classes caractérisant la région de 

Djebel Ouenza, soit le Trias en orange-clair, l’Albien en rose-violacé, le Vraconien en mélange 

de rose et marron, le Crétacé Supérieur en un mélange de bleu-cyan et rose, et on aperçoit enfin 

en couleur rose la concentration ferrifère qui se localise dans l’Aptien. 

 

En comparant le résultat obtenu par cette méthode et la carte géologique de référence de 

la région, on constate que la distinction entre les formations géologiques n’est pas conforme en 

raison de la non superposition des limites entre les couleurs n’est pas très évidente, ce qui 

empêche d’aller dans le grand détail dans l’enrichissement de l’interprétation. 
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1.5. Méthode des Bandes Ratios ou combinaison de bandes 

 

Les minéraux d’oxydes et d’hydroxydes de fer présents dans la région d’étude de 

l’Ouenza tels que l’hématie, la goethite et la jarosite (minéral d’altération) sont identifiés à partir 

de plusieurs combinaisons de bandes ratios appliquées à l’image, permettant ainsi de mettre en 

évidence cette minéralisation. Ces bandes ratios sont illustrées dans le tableau ci-dessous : 

 

Tableau 4.1 : Bandes Ratios (Elaborée par nous-mêmes) 

 

a. Combinaison 4 

Etant donné que les minéraux contenant le Fe2O3 et FeO(OH), respectivement l’hématite 

et limonite comme la goethite, ont une capacité d’absorption élevée dans les bandes 4, 5 et 6, 

d’où l’utilisation du rapport de bandes (4+6)/5 est justifiée. Sachant que l’oxyde de fer provoque 

une réflectance supérieure dans la bande 3, donc l’utilisation de celle-ci en rapport avec la bande 

4 permet de mettre en évidence l’oxyde de fer, d’où le choix de la combinaison 4.  

Figure 4.7 : Méthode des bandes ratios (Elaborée par nous-mêmes) 

MODE COMBINAISON 

1 
COMBINAISON 2 COMBINAISON 3 COMBINAISON 4 COMBINAISON 5 

R NIR 6/5 (4+6)/5 (4+6)/5 5/7 

V (4+6)/5 (4+6)/6 SWIR 1 NIR SWIR 

B 4/3 NIR Vert 6/5 Vert 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Légende  

 

 



Chapitre 4 : Interprétation des résultats                                                                                                                            . 

103 
 

En s’appuyant sur cette combinaison, on retrouve plus clairement le contraste entre la 

zone de haute concentration en fer et le reste de la région du Djebel Ouenza (Fig. 4.7).  
 

L’utilisation de ce traitement, montre la formation aptienne en vert-foncé qui contient un 

important potentiel en fer, développant ainsi une surface de forte oxydation, représentée par des 

surfaces continues en rose avec des taches disséminées dans les formations de l’Albien et le 

Vraconien en couleurs violet-vif et vert-vif où affleure une autre surface de concentration 

ferrifère et où domine le maximum des fronts de tailles d’exploitation du gisement.  
 

Cette combinaison a permis de connaître, distinguer et discriminer le fort potentiel en 

concentration ferrifère se trouvant dans la région de Djebel Ouenza. Cependant la discrimination 

entre les différentes formations, n’est pas très visible car plusieurs formations sont confondues 

et non discernables en raison de leurs couleurs similaires qu’on aperçoit sur l’image en figure 

4.7, c’est la raison pour laquelle on a procédé par un autre type de traitement qui est la fraction 

de bruit minimal (Minimum Noise Fraction).  

 

1.6. Méthode Minimum Noise Fraction 

 

La méthode MNF est utilisée pour intercepter et isoler le bruit du signal dans l’ensemble 

des données et réduire les exigences de calcul pour un meilleur rendement dans les traitements 

ultérieurs.  

 
 

Figure 4.8a : Graphe Eigenvalue MNF (Elaborée par nous-mêmes) 
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La figure 4.8a  illustre un graphique qui représente la variation des valeurs propres en 

fonctions des bandes spectrales, on remarque sur le graphe que la bande MNF1 implique les 

valeurs propres les plus élevées avec le bruit le plus faible, et que la dernière bande MNF8 

implique les valeurs propres les plus faibles avec le bruit le plus élevé. En se basant sur ce graphe 

on effectuera des essais  en combinant les bandes MNF ayant les valeurs propres les plus élevées. 

Figure 4.8b : Méthode MNF (Elaborée par nous-mêmes) 

 

Suite aux applications de plusieurs combinaisons entre les bandes, le résultat obtenu est 

une combinaison des bandes MNF1, MNF3 et MNF2 en mode RVG respectivement, comme le 

montre la figure 4.8b ci-dessus qui, donne une bonne réflectance de la surface de la région où 

l’image reflète clairement les différentes formations géologiques existantes qui se superposent 

fidèlement avec la carte géologique utilisée comme référence sur la région de Djebel Ouenza.  

 

L’interprétation de la figure 4.8, montre que l’Aptien calcaire est visible en couleur 

sombre, montrant une surface fortement oxydée où est encaissé le maximum de concentration de 

la minéralisation ferrifère, juxtaposant à l’Aptien marneux en bleu-violacé, encaissant aussi de 

moindres concentrations ferrifères, le Trias quant à lui apparait en rose. On aperçoit aussi la 

retenue collinaire de l’Oued Mellègue en bleu-cyan, localisée à l’Ouest de la région, toutefois, 

les limites des autres formations sont faiblement perceptibles en raison de la confusion des 

couleurs. 
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Discussion des résultats sur le gisement d’Ouenza 

 

L’objectif principal visant à la détermination des zones pouvant contenir des 

concentrations en fer a été atteint en utilisant un processus de traitement appliqué sur une image 

multispectrale Landsat-8-OLI de la région de Djebel-Ouenza. 

Toutes les méthodes appliquées ont donné de meilleurs/bons résultats, cependant l’unique 

méthode ayant repérer les limites de la zone contenant des concentrations ferrifères  exploitables  

est celle des bandes-ratios où la combinaison-3 a clairement localisé les surfaces d’oxydation du 

minerai de fer dans les zones déjà exploitée, avec toutefois un fort potentiel de fer au sommet de 

Djebel-Ouenza.  

 

La méthode de démixage a fourni une panoplie d’informations montrant la localisation 

des limites de la zone du minerai de différentes concentrations ferrifères, et décrivant aussi les 

limites lithologiques voisines.  

La discrimination entre les limites lithologiques a été établie par certaines méthodes en 

l’occurrence celles de la méthode Minimum Noise Fraction MNF et de la méthode de 

classification-non supervisée par Maximum Likelihood. 

 

Le choix de la méthode de traitement ayant donné le meilleur produit est celui de la 

méthode de démixage-spectrale du fait que celle-ci a produit un résultat meilleur et plus efficace 

comparé à l’ensemble des autres techniques qui n’ont pas été prises en considération même si 

elles sont complémentaires. 
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2. Résultats du traitement d’image de Gara Djebilet 
  
2.1. Amélioration des images multi-spectrales en couleurs composites 

 

2.1.1. Couleurs naturelles 

L'amélioration spectrale de l'image composite en couleur naturelle (OLI 4 : 3 : 2 ; Fig. 

4.9a) donne une image d’une assez bonne qualité, où l'ensemble de la série des Garas (Est, Centre 

et West) est en couleurs sombres, ce qui permet une meilleure distinction des limites du périmètre 

de la minéralisation ferrifère par rapport aux autres formations géologiques (étages géologiques en 

relation avec leurs lithologies) voisines qui sont visibles en couleurs claires, dont le post-paléozoïque, 

le Frasnien et le Praguien. Cependant, les limites entre le reste des formations géologiques 

voisines sont relativement perceptibles sur l’image. 

Figure 4.9a : amélioration en couleurs naturelles réelles (Elaborée par nous-mêmes) 

 

On constate un bon contraste de couleur entre la zone la plus sombre (la série des trois 

Garas) et la moins sombre de l’étage géologique du Praguien (dévonien Inférieur) localisé aux 

alentours pour représenter la variation graduelle de concentration en fer allant de la plus haute 

concentration jusqu’à la plus faible. 
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2.1.2. Fausses couleurs composites  

Figure 4.9b : Amélioration en fausses couleurs composite FCC (Elaborée par nous-mêmes) 

 

Il est généralement conseillé d’utiliser la combinaison des bandes 7, 3 et 2 représentées 

respectivement par le SWIR2, le vert et le bleu en RVB. Cette combinaison a permis d’obtenir 

de bons résultats dans le cas défini par la zone d’étude de Gara-Djebilet, et par conséquent 

distinguer clairement les limites de certaines formations lithologiques. Les concentrations de 

minéralisation ferrifère sont facilement repérées car elles sont visibles en couleur sombre de 

gamme brunâtre (Fig. 4.9b). 

 

2.2. Classification non supervisée 

  

2.2.1.ISODATA 

La classification non supervisée IsoData a été appliquée sur une image rognée à partir 

d’une scène brute contenant toutes les bandes spectrales de Landsat-8-OLI, permettant ainsi 

l’obtention d’un produit de résolution illustré par la figure 4.10a suivante. 
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Figure 4.10a: Classification non-supervisée IsoData (Elaborée par nous-mêmes) 

 

Figure 4.10b : Post-Classification non-supervisée ISODATA (Elaborée par nous-mêmes) 
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Les résultats de la classification et Post-classification ISODATA ont permis de 

discriminer les hautes concentrations de dépôts de fer visibles en couleur rouge (Figures 4.10a et 

4.10b) et représentées par la série des Garas Centre et West. Les zones de couleur orange-clair 

entourant les zones ferrifères de hautes concentrations sont constituées de grès minéralisés par 

de faibles concentrations en fer comparées à la série des trois Garas richement concentrée en 

minerai de fer. Cette méthode n’a pas donné lieu à de bons résultats pour ce qui est de la 

détermination et la délimitation des diverses formations géologiques contenant les différentes 

lithologies se trouvant dans la zone d’étude de Gara-Djebilet, ce qui nous amène à souligner que 

cette méthode n’est donc pas appropriée pour la cartographie géologique dans la région de Gara 

Djebilet. Néanmoins, la série des trois Garas est amplement mise en évidence avec des contours 

nettement délimités.  

 

2.2.2. K-means 

 

Figure 4.11a : Classification non-supervisée K-means (Elaborée par nous-mêmes) 
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Figure 4.11b : Post-Classification non-supervisée K-means (Elaborée par nous-mêmes) 

 

La méthode de classification et post-classification non supervisées K-means dont le 

principe repose sur la mise en clusters « grappes » des classes a permis de mettre en évidence les 

limites des zones riches en concentration ferrifère développant de larges surfaces continues en 

couleur rouge, soit Gara Centre et Gara Ouest comme le montre les figures 4.11a et 4.11b. 

 

Cependant, Gara-Est se caractérise par de petites surfaces rouges accusant de faibles 

concentrations ferrifères, disséminées le long d’une zone allongée W-E en couleur verte. Les 

autres lithologies ne sont pas perceptibles, ni clairement localisées avec cette méthode, mais 

d’ores et déjà, on peut constater avec une grande évidence l’étendue de l’affleurement du 

Précambrien en surface rose.  

 

L’utilisation d’une méthode autre que la classification non-supervisée est plus que 

nécessaire pour obtenir un meilleur résultat concernant la discrimination des lithologies 

affleurant dans la région de Gara Djebilet. En raison de l’existence de plusieurs classes 

« formations géologiques ou étages géologiques contenant des affinités lithologiques», on a jugé 

utile de procéder par l’application de la classification supervisée permettant de mieux gérer le 

choix de l’emplacement des classes conformément à la carte géologique de référence de la région 

de Gara-Djebilet. 
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2.3. Classification supervisée  

 

2.3.1.Maximum-Likelihood 

La classification supervisée a été réalisée en définissant 11 classes nommées ROI 

présentes dans la zone d’étude et en attribuant une couleur appropriée pour chaque région 

d’intérêt. 

Figure 4.12a : Classification Maximum Likelihood (Elaborée par nous-mêmes) 

 

Le résultat ainsi obtenu de la figure 4.12a, permet de vérifier et définir les hautes 

concentrations ferrifères indiquées par les surfaces rouges, ainsi que d’autres formations 

lithologiques dominantes formant les différentes classes. Cependant, l’image est saturée par un 

grand nombre élevé de pixels, et c’est la raison pour laquelle, le produit de la classification par 

Maximum Likelihood a été soumis par la suite à une post-classification permettant ainsi 

d’améliorer l’image de la classification. 
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Figure 4.12b : Post-classification supervisée (Maximum Likelihood) (Elaborée par nous-

mêmes) 

 

Une fois la post-classification établie, l’identification et l’extraction des informations 

géologiques à partir de l’image (Figure 4.12b)  sont plus faciles à réaliser, telles que les zones à 

l'intérieur du site d'essai, caractérisées par la présence de concentration de fer, correspondent aux 

zones rouges de l’image accusant une forte minéralisation ferrifère et les zones oranges 

périphériques représentées par le Praguien (Dévonien inférieur) accusant une faible 

minéralisation ferrifère. Concernant les autres lithologies existantes dans la région de Gara 

Djebilet, on distingue le post-Paléozoïque en jaune, le Frasnien (Dévonien supérieur) en vert, le 

Précambrien qui est visible en rouge bordeaux est surmonté par l’Ordovicien supérieur en 

magenta, le Silurien en bleu et l’Emsien (Dévonien inférieur) en gris. Par contre, le reste des 

formations lithologiques visibles sur la carte géologique de référence sont plus difficiles à 

distinguer ; malgré leur présence indiquée par les couleurs attribuées au préalable, celles-ci sont 

confondues avec les formations dominantes en raison de la similitude des ROI attribuées lors de 

l’exécution de la méthode. 

 

L’utilisation d’une autre méthode plus adéquate permettant d’améliorer les résultats 

obtenus jusqu’à présent est nécessaire dans le but de détecter le potentiel ferrifère et toutes les 

lithologies appartenant à d’autres classes y compris celles qui n’ont pas été détectées par les 

méthodes précédentes. 
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2.3.2.Spectral Angle Mapper  

Etant donné que nous nous concentrons sur l’exploration minérale pour cartographier les 

minéralisations ferrifères, nous avons utilisé les spectres des minéraux déterminés à partir des 

formations géologiques de la région.  

 

Cette classification a été réalisée sur une image Landsat-8-OLI avec une composante des 

bandes 4, 3 et 2 en RVB respectivement. 

 

Figure 4.13a : Classification supervisée par Spectral Angle Mapper (Elaborée par nous-mêmes) 

 

Dans le but d’obtenir une image beaucoup plus nette et plus représentative des limites 

géologiques, on exécute une post-classification illustrée par la figure suivante (Fig. 4.13b). 
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Figure 4.13b : Post-Classification supervisée par Spectral Angle Mapper (Elaborée par nous-

mêmes) 

 

En comparant les résultats obtenus à partir de la carte géologique de référence, on peut 

détecter et repérer les zones ferrifères d’une manière plus ou moins précise. La série des trois 

Garas sont visibles en couleur magenta représentant la formation praguienne (Dévonien 

inférieur) contenant des grès et siltites encaissant la minéralisation ferrifère, d’autant plus qu’on 

peut également remarquer la présence des zones de couleur rouge situées toujours au sein de la 

formation praguienne vérifiant les hautes concentrations en Fe.  

 

Les affleurements des autres formations géologiques présentes dans la région sont plus 

évidents, on aperçoit ainsi le Précambrien en couleur bleu et le post-Paléozoïque en vert. La zone 

où la couleur jaune est plus étendue représente la formation Frasnienne (Dévonien supérieur) 

confondue avec le Givetien (Dévonien moyen). Pour ce qui est du Silurien, Emsien (Dévonien 

inférieur), Ordovicien supérieur et Lochkovien (Dévonien inférieur), ceux-ci sont aussi 

confondus et apparaissent en couleur bleu-cyan. Par contre la formation Eifelienne (Dévonien 

moyen) n’est guère discernable sur l’image. 

 

Les deux méthodes de classification supervisée, nous ont donné la possibilité d’extraire 

des renseignements beaucoup plus précis comparés aux méthodes précédentes de la classification 

non-supervisée. Même si les résultats obtenus sont jugés satisfaisants, nous avons tout de même 

opté pour l’utilisation d’autres méthodes pouvant apporter des informations supplémentaires afin 

d’aboutir à de meilleur résultat. 
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2.4. Spectral Unmixing  

 

Cette technique est utilisée pour déterminer l’étendue de l'abondance relative des minerais 

représentés dans l'imagerie multispectrale en fonction des caractéristiques spectrales des 

minéraux. 

Figure 4.14 : Méthode de démixage par Linear Spectral Unmixing affiché en niveaux du gris 

de la bande 1 (Elaborée par nous-mêmes) 

 

Le résultat de la méthode de démixage a donné une meilleure discrimination du minerai 

de fer affiché sur un fond nuancé en gris, représenté précédemment par la figure 4.14. 

 Les minéralisations ferrifères caractérisant la série des trois Garas sont représentés en 

blanc, tandis que les affleurements des autres formations lithologiques sont visibles en nuances 

de gris.  

 

Cette méthode a fourni un meilleur résultat sur la mise en évidence de la présence du 

gisement métallique ferrifère avec des limites très perceptibles vis-à-vis des lithologies voisines, 

cependant, étant donné que les autres formations géologiques ne sont pas discernables entre elles, 

cette méthode de démixage ne sera pas considérée ou retenue comme étant exhaustive et 

informative sur le plan lithologique. 
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2.5. Bandes ratios ou combinaison de bandes 

 

Plusieurs ratios de bandes ont été utilisés pour mettre en évidence la série des trois Garas 

dans la région contenant le minerai de fer, ces bandes ratios sont illustrées sur le tableau 4.2 

suivant : 

Tableau 4.2 : Les combinaisons de bandes utilisées pour la cartographie du gisement de fer 

(Elaborée par nous-mêmes) 

Mode  COMBINAISON COMBINAISON 

2 

COMBINAISON 

3 

COMBINAISON 

4 

COMBINAISON 

5 

COMBINAISON 

6 

R 4/1 4/1 (4+6)/5 6/7 (4+6)/5 4/1 

V SWIR 1 (4+6)/5 SWIR 1 3/1 NIR 3/1 

B Vert 3/1 Vert (4+6)/5 SWIR 1 6/7 

 

Après les différents essais effectués, on opte pour deux combinaisons 3 et 6 en RVB.  

 

Combinaison 6 

Le choix de la combinaison 6, est lié au fait que le rapport 4/1 permet d’identifier le fer 

ferrique Fe3+, le rapport 3/1 pour les oxydes de fer (FexOx) et le rapport 6/7 pour les minéraux 

argileux en raison de leur présence sur le site. 

Figure 4.15a : Méthode des bandes ratios (combinaison 6) (Elaborée par nous-mêmes) 

 

Comme la région de Gara Djebilet contient majoritairement des roches telles que les grès 

et les conglomérats ferrugineux renfermant les minéraux (FeCO3, Fe2O3 et FeO(OH)) composés 

de Fe3+, on obtient une bonne résolution délimitant exclusivement du fer qu’on peut observer très 
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clairement en rouge sur l’image étant donné que le rapport 4/1 a été attribué au canal rouge. 

Cependant, les deux rapports 3/1 et 6/7 attribués aux canaux vert et bleu respectivement n’ont 

pas permis la discrimination du fer. 

 

Combinaison 3  

Figure 4.15b : Méthode des bandes ratios (combinaison 3) (Elaborée par nous-mêmes) 

 

L’utilisation de cette combinaison a produit de meilleurs résultats en montrant plus de 

détails concernant la délimitation de l’étendu des fortes concentrations ferrifères dans les Garas 

Est, Centre et Ouest qu’on peut nettement voir en couleur rouge sur l’image (4.15b). On peut 

également discerner aisément en couleur orange les zones de moindre concentration en fer, 

situées à la périphérie des zones de hautes concentrations ferrifères en couleur rouge. Le post- 

Paléozoïque est visible en couleur clair tâchée en bleu-cyan. 

 

Dans cette image en figure 4.15b, seules les minéralisations ferrifères sont différenciées 

et clairement délimitées par rapport aux autres lithologies voisines, contrairement aux autres 

formations qui restent confondues entre elles, et c’est la raison pour laquelle on a procédé par un 

autre traitement permettant d’identifier d’une manière beaucoup plus poussée à la fois les limites 

des autres lithologiques et les gisements de fer de toute la série des Gara-Djebilet. 
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2.6. Transformation Minimum Noise Fraction  

 

La transformation MNF a pour but d’éliminer le bruit et délimiter les unités lithologiques 

dans la zone d'étude. Elle permet aussi d’identifier les emplacements des anomalies spectrales. 

La méthode MNF a été appliquée aux huit bandes de l’image Landsat-8-OLI. Les résultats 

obtenus montrent que les dernières MNF soit MNF7 et MNF8 ne contiennent aucune information 

utile en raison de la grande quantité de bruit qu’elles interceptent, celles-ci ne sont donc pas 

prises en considération lors de l’interprétation. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.16a : Graphe des valeurs propres (Eigenvalue) de la méthode MNF (Elaborée par nous-

mêmes) 

 

Les résultats obtenus de cette transformation MNF montrent une relative diminution de la qualité 

d’image jusqu’à la dernière MNF pour les autres lithologies, néanmoins, la qualité d’image pour 

la série ferrifère des trois Garas est amplement exhaustive. 
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Figure 4.16b : Minimum Noise Fraction (Elaborée par nous-mêmes) 

 

La figure 4.16b est le résultat de la combinaison des bandes MNF2, MNF3 et MNF4 en 

RVB respectivement. 

 

La région d’étude de la série des gara-Djebilet, caractérisée par la minéralisation d’une 

forte concentration ferrifère, correspond aux zones blanches de l’image (Figure 4.16b). Le post- 

Paléozoïque est visible en vert-fluo, tandis que le Précambrien apparait en bleu. 

 

Discussions des résultats sur le gisement de Gara-Djebilet  

L’ensemble des techniques de mise en valeur appliquées sur l’image multispectrale 

Landsat-8- OLI de la région de Gara-Djebilet, ont permis d’obtenir des résultats plus ou moins 

satisfaisants concernant la localisation et la détection des limites et étendue du gisement ferrifère 

de la série des trois Gara-Djebilet en relation avec les limites d’autres formations géologiques.  

Les résultats de chaque méthode diffèrent les uns des autres par l’information extraite sur la 

discrimination des diverses formations géologiques. Parmi ces méthodes, certaines ont donné de 

meilleurs produits pour souligner la présence et la distinction des limites des concentrations 

ferrifères juxtaposant d’autres lithologiques voisines.  

 

Par exemple, la méthode des bandes- ratios où la combinaison-6 a montré uniquement 

les zones à haute concentration en fer, soit Gara-Centre et Gara-Ouest, ainsi que la méthode de 

démixage spectral qui a donné un résultat similaire ayant mis en évidence les trois Gara,  

Cependant, l’amélioration en fausses couleurs composite (FCC) ainsi que la méthode de la 

classification supervisée par Maximum Likelihood et la méthode Minimum Noise Fraction 

(MNF) ont permis de différencier entre toutes les lithologies existantes. 
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Toutefois, l’obtention d’un produit final contenant toutes les informations utiles sur la 

zone d’étude de Gara-Djebilet, nous a conduits à sélectionner et retenir la classification 

supervisée par Maximum Likelihood comme étant la méthode ayant donné des résultats forts 

convenables aussi bien pour la détection et la localisation géographique des limites des surfaces 

de concentrations ferrifères de la série des Gara-Djebilet que pour la distinction des autres limites 

lithostratigraphiques adjacentes et voisines.  
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Comparaison et conclusion  

Grâce à la télédétection, deux cas d’étude, portant sur deux régions géologiques 

différentes sur plusieurs plans, ont été choisis pour évaluer l'efficacité des                                          

multiples techniques de traitement d'images pour cartographier les limites des gisements 

métalliques ferrifères et discriminer les différentes limites lithostratigraphiques adjacentes et 

voisines.  

Le premier concerne le Djebel-Ouenza dans le Nord-Est algérien et le deuxième celui de 

Gara-Djebilet dans le Sud-Ouest algérien, caractérisés par la présence des formations 

géologiques de fortes concentrations en minerai de fer. 
 

Une série de méthodes de traitement d’images a été appliquée sur les deux régions 

d’études renfermant les gisements de fer, dont celles de l’amélioration en couleurs-composites, 

la classification non-supervisée, la classification-supervisée, la méthode-MNF, la méthode des 

bandes-ratios et la méthode de démixage-spectrale.  
 

Cependant, les différentes propriétés spécifiques de chaque région, du point de vue de 

conditions bioclimatiques inhérentes à la situation géographique, la région de Djebel-Ouenza, 

correspond à un espace naturel rural comportant des massifs forestiers et des points de sources 

d’eaux naturelles, est caractérisée par un climat mitigé entre sub-humide à semi-aride, quant à la 

région de Gara-Djebilet, elle correspond à un espace naturel désertique caractérisé par un climat 

aride. Ce qui revient à dire que la méthode utilisée et jugée adéquate pour chaque région d’étude 

est différente. 
 

Les résultats obtenus et discutés auparavant dans notre travail de recherche, nous ont 

permis d’obtenir des données analytiques propres à chaque région, où l’on remarque au niveau 

de la région de l’Ouenza, l’existence d’une certaine dissemblance ou écart avec la carte 

géologique de référence, se traduisant par un relatif décalage entre les limites de la zone de 

concentration ferrifère qui se confondent avec celles des autres formations lithologiques voisines 

où, en raison des travaux antérieurs d’exploitations du minerai de fer assistés par les effets des 

altérations chimiques, d’innombrables masses rocheuses du minerai sont déployées et 

disséminées à travers toutes les surfaces des formations voisines, ce qui a provoqué un 

foisonnement et un mélange enregistrés à la surface  lithologique de ces formations géologiques 

voisines, situées à la périphérie de la zone de concentration du minerai du fer.   

 

Cependant, les résultats obtenus de la région de Gara-Djebilet ont montré une bonne 

corrélation avec la carte géologique de référence, exprimant une concordance et conservation 

aussi fidèle que possible des limites lithostratigraphiques de toutes les formations géologiques 

de la région qui sont restées à l’état naturel juvénile, en raison de l’absence des travaux 

d’exploitation du gisement. 
 

Notons que l’intérêt de l’utilisation de la télédétection dans le domaine minier s’étend à 

plusieurs plans, en l’occurrence la prospection minière pour la détection et les limites de 

nouveaux gisements minéraux (ressources), et la configuration de leurs géométries au moyen 

d’une modélisation en 3D avant d’engager les travaux d’exploitation, ce qui est valable pour le 

cas du gisement ferrifère de la série des Gara-Djebilet dont les limites des formations 
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géologiques de toute la région sont très bien conservées en raison de la non-entame des travaux 

d’exploitation du gisement, et aussi de leur position géographique dominée par un climat à 

caractère sec et chaud à froid, d’où le déficit d’humidité de l’air et son effet sur l’absence 

d’altération chimique sur les roches de surfaces.  
 

Cependant, en ce qui concerne le gisement ferrifère de l’Ouenza, dont les travaux 

d’exploitation sont en cours depuis plus de cinquante ans, l’apport de la télédétection se résume 

fondamentalement à superviser l’évolution des travaux d’exploitation et surtout orienter les 

travaux d’exploitation vers les zones de concentration à teneur de coupure exploitable. 

Contrairement à la région de Gara-Djebilet, les limites des formations géologiques de la région 

de l’Ouenza ne sont guère conservées en raison de l’altération chimique plus ou moins prononcée 

et générée par un climat à caractère humide qui, a été à l’origine de l’altération chimique affectant 

aussi bien le chevauchement des limites que les surfaces des formations géologiques voisines. 
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CONCLUSION GENERALE 

  

L’apport de la télédétection dans la prospection minière est devenu incontestable et plus 

qu’impératif, pour ne pas dire exigeant dans certaines conditions de régions jugées 

inaccessibles. Les progrès techniques de la télédétection font que nous pouvons extraire 

davantage de détails sur les informations enregistrées sur les supports d’images-satellites.  
 

Toutefois, l’avantage de ce travail de recherche, nous a offert une grande opportunité 

pour mettre à profit la réalisation d’une étude de prospection minière comparative tout en 

s’appuyant sur les différentes techniques de traitement d’images-satellites appliquées à deux 

différentes régions géologiques d’Algérie, Djebel-Ouenza au Nord-Est et Gara-Djebilet au 

Sud-Ouest.  
 

 

La présente étude a mis l’accent sur l’efficacité et l'utilité des données Landsat-8-OLI 

pour la détection et la cartographie de la distribution spatiale des zones, appartenant à deux 

régions géologiques différentes, contenant des gisements de minerai de fer à concentration 

exploitable.  
 

Diverses méthodes de traitements d’images relatives à la télédétection ont été utilisées 

dans notre étude, dont l’amélioration multispectrale des images, la classification non-

supervisée et supervisée, la méthode de démixage spectral, la méthode des bandes ratios et la 

MNF.  
 

 

Les résultats de ces différentes méthodes utilisées et appliquées à nos deux zones 

d'études offrent des perspectives intéressantes motivant la possibilité de détecter d’autres 

gisements ferrifères exploitables, et permettent aussi une cartographie rapide et peu coûteuse 

des caractéristiques géologiques des différentes surfaces terrestres.  
 

 

L’approche de notre travail de recherche s’est attelée à trouver une méthode idoine 

adaptée pour l’extraction d’informations lithologiques, lorsqu’il s’agit de régions géologiques 

abritant des gisements déjà exploités et non-exploités, et comme nous l’avons déjà discuté dans 

le dernier chapitre, la méthode de classification-supervisée a été tout à fait satisfaisante pour le 

cas de Gara-Djebilet, cependant la méthode de démixage spectral a donné de meilleurs résultats 

pour le cas de Djebel-Ouenza. De ce fait, nous avons pu mettre en évidence les limites et 

l’étendue des zones de concentrations ferrifères par rapport à celles des formations géologiques 

voisines.  
 

En effet, pour le cas du gisement ferrifère non-exploité de la série de Gara-Djebilet, la 

discrimination des limites lithostratigraphiques est clairement discernable, aussi bien entre les 

zones de concentrations ferrifères et les formations adjacentes que celle observée entre toutes 

les autres formations géologiques voisines de toute la région, alors que pour le cas du gisement 

ferrifère en cours d’exploitation de Djebel-Ouenza, seules les limites lithologiques de la zone 

de concentration ferrifère avec les autres formations voisines sont discernables, tandis que la 

discrimination des limites lithostratigraphiques entre les autres formations voisines sont très 

confuses pour des raisons qui ont été déjà élucidées. 
 

La méthodologie adoptée dans notre projet de fin d’études peut être appliquée et 

généralisée, de manière profitable, à d’autres régions éloignées et parfois difficilement 

accessibles du territoire algérien, nécessitant des moyens financiers, humains et logistiques 

lourds et coûteux. D’autant plus que cette méthodologie pourrait fournir de grandes 
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perspectives sur la possibilité de détecter l’existence de nouveaux gisements métalliques 

ferrifères et non ferrifères à concentrations exploitables et de repérer fidèlement leurs 

localisations géographiques avec une très grande précision à partir d’une station de recherche 

sans pour autant engager de gros moyens d’investissements qui pourraient s’avérer inutiles dans 

le cas de certaines ressources à teneur non exploitable présentant de très minces résultats 

positifs. L’avantage de cette nouvelle méthodologie de recherche en prospection minière offerte 

par la télédétection garantit au domaine minier un développement durable et efficace permettant 

de rentabiliser le rapport coût-avantage en termes de gain de temps, financement et moyens 

logistiques de terrain dans des régions géologiques éloignées et inaccessibles.  

Une autre approche de prospection minière peut être réalisée afin de compléter ou 

d’améliorer les résultats obtenus à partir des données multi-spectrales de Landsat-8-OLI, réside 

dans l’utilisation d’un autre type de capteur, à titre d’exemple l’outil ASTER qui est connu pour 

sa puissante performance dans la cartographie géologique.  

De plus, on souligne pour notre travail de recherche, que la disponibilité des données de 

prospections géophysiques et les logs de forages en relation avec les coordonnées 

géographiques X, Y et Z  sur les deux gisements, nous auraient permis non seulement la 

construction d’un modèle en 3D décrivant la configuration géométrique des deux régions 

d’études pour mettre en relief les zones de concentrations ferrifères, mais aussi l’estimation des 

réserves géologiques ferrifères de chaque gisement dans l’optique d’apporter plus 

d’informations utiles à la détermination du tonnage à extraire, conformément à la teneur de 

coupure déjà calculée, et aussi de la durée de vie du gisement Mais à notre grande stupéfaction 

et déception, et en dépit de nombreuses tentatives de contact établies avec les différentes 

entreprises minières, publiques et privées, les sollicitant de nous fournir ces données de terrains, 

malheureusement, toutes nos demandes sont restées sans suite, avec parfois un refus validé par 

le fait que ces données constituent une propriété confidentielle propre à ces entreprises. 
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Annexe 1 

Interface du logiciel ENVI Classic 

 

 

 

Figure A.1 : Interface ENVI Classic 

  



. 

 
 

136 
 

Annexe 2 

Création d’un fichier multibandes ou empilement de couches 

Dans ENVI Classic sélectionner Basic Tools à partir du menu → Layer stacking → Import File 

(sélectionner les images représentant chaque bande). 

 

Figure A.2a : Fichier d’entrée d’empilement des couches 

 

Figure A.2b : Configuration des paramètres d’empilement des couches 
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Figure A.2c : Résultat de l’empilement des couches (Layer stacking) 
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Annexe 3 

Obtention des sous-scènes des images Landsat 8 OLI  

 

Figure A.3a : Fichier d’entrée des données de redimensionnement 

A partir du menu, sélectionner File → Open Image File (choisir l’image) → Basic Tools → 

Resize Data → Spatial Subset. 
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Le choix des dimensions des deux régions s’est fait par analogie entre les images satellites 

collectées et les cartes géologiques de référence. 

 

 

 

 

 

 

 

 

 

 

 

 

Figures A.3b : Dimensions du 

sous-ensemble spatial de Gara- 

Djebilet 

 

Figures A.3c : Dimensions du 

sous-ensemble spatial de Djebel 

Ouenza 
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Annexe 4 

Amélioration multispectrales des images en couleur composite 

1. Couleurs naturelles 

 

 

 

 

Dans le menu, sélectionenr File → Open Image File → 

sélectionner le fichier déjà empilé. 

Pour l’amélioration en couleurs naturelles, attribuer la 

bande rouge pour le canal rouge, la bande verte pour le 

canal vert et la bande bleue pour le canal bleu en mode 

RGB Color. 

Pour visualiser le résultat, cliquer sur Load RGB. 

 

 

 

 

 

2. Fausses couleurs 

 

Dans le menu, sélectionenr File → Open Image File → 

sélectionner le fichier déjà empilé. 

Pour l’amélioration en fausses couleurs, attribuer les  

bandes 7, 3 et 2 pour le canal rouge, le canal vert et le 

canal bleu respectivement en mode RGB Color. 

Pour visualiser le résultat, cliquer sur Load RGB. 

 

 

 

 

 

 

 

Figure A.4 : Affichage en 

couleurs naturelles 

Figure A.5 : Affichage en 

fausses couleurs  
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Annexe  5 

La classification non supervisée 

 

1. ISODATA 

 

Dans le menu, cliquer sur Classification → Unsupervised  → IsoData (choisir l’image). 

 

 

 

 

 

 

 

 

 

 

Figure A.6a : paramètres par défaut ISODATA 

En choisissant l’algorithme IsoData, la fenêtre de configuration du classificateur s’affiche :  

 

 

Pour la région de Gara Djebilet, on 

sélectionne un nombre de classes compris 

entre 6 et 10, nombre d’itération égale à 4  

pour effectuer le programme et aussi 7 

pixels regroupés pour une classe 

 

 

 

 

 

 

Figure A.6b : Paramètres 

ISODATA de Gara-Djebilet 
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2. K-means 

Dans le menu ENVI Classic, cliquer sur Classification → Unsupervised → k-means (choisir 

l’image). 

En choisissant la méthode de classification non supervisée K-means, la fenêtre de configuration 

des paramètres s’affiche (Fig. A.7a) :  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Le choix du nombre de classes est lié au nombre de formations lithologiques présentes sur la 

carte géologique de la région, c’est pour cela que le nombre de classes a été défini sur 12.  

 

 

Figure A.6c : Paramètres 

ISODATA de Djebel Ouenza 

 

Pour la région de l’Ouenza, on 

sélectionne un nombre de classes 

compris entre 6 et 10, un nombre 

d’itération égale à 3 pour effectuer le 

programme et aussi 14 pixels 

regroupés pour une classe. 
 

 

Figure A.7a : Paramètres K-means 

par défaut 
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Le nombre d’itérations maximal est, dans ce cas 

égal à 5, et ce, selon les résultats des nombreux 

essais effectués. 

 

 

 

 

 

 

 

 

 

 

 

 

Par contre, pour la région de Djebel Ouenza de 

nombre des classes est égal à 6 et le nombre 

d’itérations est de 8. 

 

 

 

 

 

 

 

 

 

 

 

Figure A.7b : Paramètres K-means 

pour  la région de Gara Djebilet 

Figure A.7c : Paramètres K-means 

pour la région de  Djebel Ouenza 
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Annexe 6 

La classification supervisée 

1. Maximum Likelihood 

Dans le menu ENVI on sélectionne File → Open Image File → Sélectionner l’image empilée. 

Une fois l’image affichée, on clique sur Tools dans la barre de menu de l’image → ROI Tool, 

on obtient boite de dialogue par défaut. 

 
 

Figure A.8a : Boite de dialogue ROI par défaut  

 

Une fois la boite de dialogue  ouverte on définit la région d’intérêt ROI sur l’image en attribuant 

la surface adéquate pour chaque classe ainsi qu’une couleur représentative. 

Dans le menu de ROI Tool → Sélectionner Select All → File → Save ROIs → Select All 

items → choisir le nom de fichier de sortie → OK. 

 
 

Figure A.8b : Configuration des paramètres de la région d’intérêt de Gara Djebilet 
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Pour la région de Gara Djebilet on choisit 11 ROI représentatifs de la région et ce par analogie 

avec la carte géologique de référence, tandis que pour la région de l’Ouenza on définit 6 régions 

d’intérêt. 

  
 

Figure A.8c : Configuration des paramètres de la région d’intérêt de Djebel Ouenza 

 

Une fois la définition des ROI est faite, on procède à l’application de la classification du 

Maximum de Vraisemblance comme suit : 

Dans la menu ENVI sélectionner Classification → Supervised → Maximum Likelihood → 

Sélectionner l’image contenant les ROI → OK → Select All items → OK. 

 
 

Figure A.8d : Configuration des paramètres de Maximum Vraisemblance de Gara-Djebilet 
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Figure A.8e : Configuration des paramètres de Maximum Vraisemblance de l’Ouenza 

 

2. Spectral Angle Mapper 

Pour réaliser la méthode SAM, il faut tout d’abord créer une librairie spectrale comme suit :  

Dans ENVI, cliquer sur File → Open Image File → sélectionner l’image résultante de 

l’empilement. 

Dans le menu de l’image affichée, sélectionner Tools → Profiles → Z Profile (Spectrum). Le 

profil spectral de la figure (A.9a)  s’affiche. 

Dans le menu du profil spectral affiché, cliquer sur Option → Plot Key. Le profil spectral de la 

figure (A.9b)  s’affiche. 

Encore une fois, dans le menu du profil spectral cliquer sur Options → New Window : with 

Plots…   
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Aller sur l’image et cliquer sur une zone 

représentative de la lithologie ou classe souhaitée, puis glisser les coordonnées X et Y qui 

s’affichent sur le profil spectral vers la fenêtre du graphique puis, dans le menu de la boite de 

dialogue Plot Window cliquer sur Edit → Data Parameters.   

 

 

Dans la boite de dialogue Data Parameters, attribuer le 

nom de la classe sélectionnée dans la case Name, et 

attribuer une couleur dans la case Color. 

Répéter les étapes pour toutes les classes/lithologies 

de l’image. 

 

 

 

 

 

 

 

 

 

 

 

Figure A.9a : Profil spectral Figure A.9b : Fenêtre du 

graphique 

Figure A.9c : Paramètres des 

données 
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Dans la fenêtre Plot Window cliquer sur File → 

Save Plot As → Spectral Library. Puis, dans la boite 

de dialogue qui s’affiche cliquer sur Select All items 

puis sur OK. 

Une autre boite de dialogue s’affiche (Fig. A.9f), 

cliquer sur OK. 

 

 

 

 

 

 

 

On obtient ainsi une librairie spectrale pour chaque région : 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure A.9e : Librairie spectrale de la région de Gara Djebilet 

Figure A.9d : Librairie spectrale 

de sortie 
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Figure A.9f : Librairie spectrale de la région de Djebel Ouenza 

Pour appliquer la classification supervisée, cliquer sur Classification : Supervised : Spectral 

Angle Mapper : Sélectionner le fichier d’entrée : OK 

Dans la boite de dialogue Input Spectral Library cliquer sur Select All items : ok  

Dans la nouvelle boite de dialogue qui s’affiche, cliquer sur Select All : Apply. La boite de 

dialogue suivante s’affiche (Fig A.9g) cliquer sur OK. 

  

 

 

 

 

 

  

Figure A.9g : Paramètres Spectral 

Angle Mapper 
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Annexe 7 

La post classification  

 

Dans le menu Envi sélectionner Classification → Post Classification → Majoity/Minority 

Analysis → Sélectionner l’image à traiter → OK. 

L’image à traiter représente le produit obtenu à partir des techniques de classification supervisée 

et non supervisée.  

 

 

 

 

 

 

 

 

 

 

 

 

Figure A.10a : Fichier d’entrée de la classification 
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Figure A.10b : Paramètres de la post classification Majority/Minority  

 

Dans le menu ENVI, cliquer sur Classification → Post Classification → Clump →  Sélectionner 

l’image obtenue de la poste classification précédente → MMA → OK. 
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Figure A.10c : Fichier d’entrée de la classification 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure A.10d : Paramètres de la post classification Clump Classes  
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Annexe 8 

Le démixage spectral 
 

 
 

Figure A.11a : Fichier d’entrée de Démixage par défaut 

 

Une fois l’image sélectionnée → Cliquer sur Import → From Spectral Library file → 

open → New file → Sélectionner la librairie spectrale adéquate → OK → Select All 

items → OK. 

Nous avons utilisé la même librairie spectrale que celle de la méthode Spectral Angle 

Mapper définie auparavant pour les deux régions. 

Pour Gara Djebilet 

 
 

Figure A.11b : Collecte des membres finaux pour Gara Djebilet 

 

 

Dans la barre de menu ENVI → Sélectionner 

Spectral → Mapping Methods → Linear Spectral 

Unmixing → Sélectionner l’image empilée → OK. 
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Pour l’Ouenza 

 

Figure A.11c : Collecte des membres finaux pour Djebel Ouenza 

Une fois les spectres importés : cliquer sur Select All → Apply. 
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Annexe 9 

Les bandes ratios 
Dans ENVI, cliquer sur File → Open Image File → sélectionner l’image résultante de 

l’empilement. 

Dans le menu ENVI, cliquer sur Basic Tools → 

Band Math → affichage de la figure ci-contre : 

 

Après avoir inséré l’expression du rapport, 

cliquer à chaque fois sur Add to list. 

Une fois tous les rapports ajoutés, cliquer sur 

OK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure A.12b : Association des 

variables aux bandes 

Figure A.12.a : Boite de dialogue 

Band Math 
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Définir les bandes des ratios à partir des 

bandes de l’image à traiter et cliquer sur 

OK. Une fois tous le rapport défini, 

choisir Memory pour le paramètre 

Output Result to, comme illustré dans la 

figure ci-contre : 

 

 

 

 

 

 

 

 

 

 

 

Après avoir défini tous les ratios, on obtient le 

résultat représenté dans la figure (A.12d) :  

 

 

 

 

 

 

 

Figure A.12c : Définition des 

bandes des rapports 

Figure A.12d : Rapports définis 
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Pour visualiser le résultat, attribuer pour chaque canal un rapport ou une bande et cliquer sur 

load RGB. 

Figure A.12e : Combinaison 3 

pour la région de Gara Djebilet 

Figure A.12f : Combinaison 6 

pour la région de Gara Djebilet 

Figure A.12g : Combinaison 3 

pour la région de Djebel Ouenza 
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Annexe 10 

Minimum Noise Fraction (MNF) 
 

Dans la barre menu ENVI cliquer sur Transform → MNF Rotation → Forward MNF → 

Estimate Noise Statistics from Data → Sélectionner l’image empilée → OK. 

 

  
 

On obtient la fenêtre illustrée par la 

figure A.13a, et par la suite on 

remplit les cases vides comme citée 

sur la figure. 

Figure A.13 : Paramètres de la 

transformation MNF 

 


